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Chapter 29
Window Reference

This chapter provides a reference to the various windows of the Time Series Forecast-
ing system. The windows are presented in alphabetical order by name. Each section
describes the purpose of the window, how to bring it up, and its controls, fields, and
menus. For windows which have their own pull-down menus, there is a description
of each menu item under the headingmenu bar . These windows also have a tool
bar with icons duplicating the more commonly used menu items. Each icon has a
screen tip : A brief description which appears when you place the mouse cursor
over the icon. If you don’t see the screen tips, bring up the SASPreferences
window, under theOptions submenu of theTools pull-down menu. Select the
View tab and make sure thescreen tips check box is checked.

Adjustments Selection Window

Use the Adjustments Selection window to select input variables for use as adjust-
ments to the forecasts and add them to the Predictors list. Invoke this window from
the pop-up menu which appears when you select theAdd button of the ARIMA
Model Specification window or Custom Model Specification window. For more in-
formation, see theAdjustmentssection in Chapter 27, “Using Predictor Variables.”

Controls and Fields
Dependent

is the name and variable label of the current series.

Adjustments
is a table listing the names and labels in the input data set available for selection
as adjustments. The variables you select are highlighted. Selecting a highlighted
row again deselects that variable.
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Part 3. General Information

OK
closes the Adjustments Selection window and adds the selected variables as ad-
justments in the model.

Cancel
closes the window without adding any adjustments.

Reset
resets all selections to their initial values upon entry to the window.

ARIMA Model Specification Window

Use the ARIMA Model Specification window to specify and fit an ARIMA model
with or without predictor effects as inputs. Access it from the Develop Models menu,
where it is invoked from the Fit Model item under Edit in the menu bar, or from the
pop-up menu when you click an empty area of the model table.

Controls and Fields
Series

is the name and variable label of the current series.

Model
is a descriptive label for the model that you specify. You can type a label in this
field or allow the system to provide a label. If you leave the label blank, a label
is generated automatically based on the options you specify.

ARIMA Options
Use these combo boxes to specify the orders of the ARIMA model. You can
either type in a value or click the combo box arrow to select from a popup
list.

Autoregressive
defines the order of the autoregressive part of the model.

Differencing
defines the order of simple differencing, for example, first difference or
second difference.
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Moving Average
defines the order of the moving average part of the model.

Seasonal ARIMA Options
Use these combo boxes to specify the orders of the seasonal part of the ARIMA
model. You can either type in a value or click the combo box arrow to select
from a popup list.

Autoregressive
defines the order of the seasonal autoregressive part of the model.

Differencing
defines the order of seasonal differencing, for example, first difference or
second difference at the seasonal lags.

Moving Average
defines the order of the seasonal moving average part of the model.

Transformation
defines the series transformation for the model. When a transformation is spec-
ified, the ARIMA model is fit to the transformed series, and forecasts are pro-
duced by applying the inverse transformation to the ARIMA model predictions.
The available transformations are:Log, Logistic, Square Root, Box-
Cox, andNone.

Intercept
The optionsYes and No enable you to specify whether a mean or intercept
parameter is included in the ARIMA model. By default, the Intercept option
is set to No when the model includes differencing and Yes when there is no
differencing.

Predictors
This table lists the predictor effects included as inputs in the model.

OK
closes the ARIMA Model Specification window and fits the model.

Cancel
closes the ARIMA Model Specification window without fitting the model. Any
options you specified are lost.

Reset
resets all options to their initial values upon entry to the ARIMA Model Specifi-
cation window. This may be useful when editing an existing model specification;
otherwise, Reset has the same function as Clear.

Clear
resets all options to their default values.

Add
brings up a menu of types of predictors to add to the Predictors list.

Delete
deletes the selected (highlighted) entry from the Predictors list.

Edit
edits the selected (highlighted) entry in the Predictors list.
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Mouse Button Actions
You can select or deselect entries in the Predictors list by positioning the mouse cursor
over the entry and clicking the left mouse button. The selected (highlighted) predictor
effect is acted on by theDelete andEdit buttons. Double-clicking on a predictor
in the list invokes an appropriate edit action for that predictor.

If you position the mouse cursor over the Predictors list and click the right mouse
button, the system displays the following menu of actions encompassing the features
of theAdd, Delete , andEdit buttons.

Add Linear Trend
adds a Linear Trend item to the Predictors list.

Add Trend Curve
brings up a menu of different time trend curves and adds the curve you select to
the Predictors list. Certain trend curve specifications also set theTransfor-
mation field.

Add Regressors
brings up the Regressors Selection window to enable you to select other series
in the input data set as regressors to predict the dependent series and add them
to the Predictors list.

Add Adjustments
brings up the Adjustments Selection window to enable you to select other series
in the input data set for use as adjustments to the forecasts and add them to the
Predictors list.

Add Dynamic Regressor
brings up the Dynamic Regressor Selection window to enable you to select a
series in the input data set as a predictor of the dependent series and also specify
a transfer function model for the effect of the predictor series.

Add Interventions
brings up the Interventions for Series window to enable you to define and select
intervention effects and add them to the Predictors list.

Add Seasonal Dummies
adds a Seasonal Dummies predictor item to the Predictors list.

Edit Predictor
edits the selected (highlighted) entry in the Predictors list.

Delete Predictors
deletes the selected (highlighted) entry from the Predictors list.

ARIMA Process Specification Window

Use the ARIMA Process Specification window to define ARIMA processes for sim-
ulation. Invoke this window from theAdd Series button in the Time Series Sim-
ulation window.
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Controls and Fields
Series Name

is the variable name for the series to be simulated.

Series Label
is the variable label for the series to be simulated.

Series Mean
is the mean of the simulated series.

Transformation
defines the series transformation.

Simple Differencing
is the order of simple differencing for the series.

Seasonal Differencing
is the order of seasonal differencing for the series.

AR Parameters
is a table of Autoregressive terms for the simulated ARIMA process. Enter a
value for Factor, Lag, and Value for each term of the AR part of the process
you want to simulate. For a non-factored AR model, make the Factor values
the same for all terms. For a factored AR model, use different Factor values to
group the terms into the factors.

MA Parameters
is a table of Moving Average terms for the simulated ARIMA process. Enter
a value for Factor, Lag, and Value for each term of the MA part of the process
you want to simulate. For a non-factored MA model, make the Factor values
the same for all terms. For a factored MA model, use different Factor values to
group the terms into the factors.

OK
closes the ARIMA Process Specification window and adds the specified process
to the Series to Generate list in the Time Series Simulation window.
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Cancel
closes the window without adding to the Series to Generate list. Any options
you specified are lost.

Reset
resets all the fields to their initial values upon entry to the window.

Clear
resets all the fields to their default values.

Automatic Model Fitting Window

Use the Automatic Model Fitting window to perform automatic model selection on
all series or selected series in an input data set. Invoke this window using theFit
Models Automatically button on the Time Series Forecasting window.

Controls and Fields
Project

the name of the SAS catalog entry in which the results of the model search
process are stored.

Input Data Set
is the name of the current input data set. You can type in a one or two level data
set name here.

Browse button
brings up theData Set Selection window for selecting an input data set.

Time ID
is the name of the ID variable for the input data set. You can type in the variable
name here, or use theSelect or Create button.

time ID Select button
brings up the Time ID Variable Specification window.

time ID Create button
brings up a menu of choices of methods for creating a time ID variable for the
input data set. Use this feature if the input data set does not already contain a
valid time ID variable.
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Interval
is the time interval between observations (data frequency) in the current input
data set. You can type in an interval name or select one using the combo box
popup menu.

Series to Process
indicates the number and names of time series variables for which forecasting
model selection will be applied.

Series to ProcessSelect button
brings up the Series to Process window to let you select the series for which you
want to fit models.

Selection Criterion
shows the goodness-of-fit statistic that will be used to determine the best fitting
model for each series.

Selection CriterionSelect button
brings up the Model Selection Criterion window to enable you to select the
goodness-of-fit statistic that will be used to determine the best fitting model for
each series.

Run button
begins the automatic model fitting process.

Models Fit button
invokes theAutomatic Model Fitting Results window to display
the models fit during the current invocation of the Automatic Model Fitting Win-
dow. The results appear automatically when model fitting is complete, but this
button enables you to redisplay the results window.

Close button
Closes the Automatic Model Fitting window.

Menu Bar
File

Import Data
is available if you license SAS/Access software. It brings up an Import
Wizard which you can use to import your data from an external spreadsheet
or data base to a SAS data set for use in the Time Series Forecasting System.

Export Data
is available if you license SAS/Access software. It brings up an Export
Wizard which you can use to export a SAS data set, such as a forecast
data set created with the Time Series Forecasting System, to an external
spreadsheet or data base.

Print Setup
brings up thePrint Setup window, which allows you to access your
operating system print setup or choose SAS/Graph print drivers.

Close
Closes the Automatic Model Fitting window.
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View

Input Data Set
brings up a Viewtable window to browse the current input data set.

Models Fit
brings up Automatic Model Fitting Results window to show the forecasting
models fit during the current invocation of the Automatic Model Fitting
window. This is the same as theModels Fit button.

Tools

Fit Models
performs the automatic model selection process for the selected series. This
is the same as theRun button.

Options

Default Time Ranges
brings up the Default Time Ranges window to enable you to control how
the system sets the time ranges for series.

Model Selection List
Brings up the Model Selection List window. Use this action to control the
forecasting models considered by the automatic model selection process
and displayed in the Models to Fit window.

Model Selection Criterion
brings up the Model Selection Criterion window, which presents a list of
goodness-of-fit statistics and enables you to select the fit statistic that is
displayed in the table and used by the automatic model selection process to
determine the best fitting model. This action is the same as the Selection
CriterionSelect button.

Statistics of Fit
brings up the Statistics of Fit Selection window, which presents a list of
statistics that the system can display. Use this action to customize the list
of statistics shown in the Statistics of Fit table and available for selection in
the Model Selection Criterion menu.

Forecast Options
brings up the Forecast Options window, which enables you to control the
widths of forecast confidence limits and control the kind of predicted values
computed for models that include series transformations.

Forecast Data Set
seeProduce Forecasts window.

Alignment of Dates

Beginning
aligns dates that the system generates to identify forecast observations
in output data sets to the beginning of the time intervals.
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Middle
aligns dates that the system generates to identify forecast observations
in output data sets to the midpoints of the time intervals.

End
aligns dates that the system generates to identify forecast observations
in output data sets to the end of the time intervals.

Automatic Fit
brings up the Automatic Model Selection Options window, which enables
you to control the number of models retained by the automatic model se-
lection process and whether the models considered for automatic selection
are subset according to the series diagnostics.

Tool Bar Type

Image Only
displays the tool bar items as icons without text.

Label Only
displays the tool bar items as text without icon images.

Both
displays the tool bar items with both text and icon images.

Include Interventions
controls whether intervention effects defined for the current series are au-
tomatically added as predictors to the models considered by the automatic
selection process. A check mark or filled check box next to this item indi-
cates that the option is turned on.

Print Audit Trail
prints to the SAS log information about the models fit by the system. A
check mark or filled check box next to this item indicates that the audit
option is turned on.

Show Source Statements
controls whether SAS statements submitted by the forecasting system are
printed in the SAS log. When the Show Source Statements option is se-
lected, the system sets the SAS system option SOURCE before submitting
SAS statements; otherwise, the system uses the NOSOURCE option. Note
that only some of the functions performed by the forecasting system are
accomplished by submitting SAS statements. A check mark or filled check
box next to this item indicates that the option is turned on.

Automatic Model Fitting Results Window

This resizable window displays the models fit by the most recent invocation of the
Automatic Model Fitting window. It appears automatically after Automatic Model
Fitting runs, and can be brought up repeatedly from that window using the Models
Fit button or by selecting Models Fit from the View pull-down menu. Once you exit
the Automatic Model Fitting window, the Automatic Model Fitting Results window
cannot be opened again until you fit additional models using Automatic Model Fit-
ting.
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Table Contents
The results table displays the series name in the first column and the model label in
the second column. If you have chosen to retain more than one model using theAu-
tomatic Model Selection Options window, more than one row appears
in the table for each series; that is, there is a row for each model fit. If you have
already fit models to the same series before invoking the Automatic Model Fitting
window, those models do not appear here, since the Automatic Model Fitting Results
window is intended to show the results of the current operation of Automatic Model
Fitting. To see all models which have been fit, use the Manage Projects window.

The third column of the table shows the values of the current model selection cri-
terion statistic. Additional columns show the values of other fit statistics. The set
of statistics shown are selectable using theStatistics of Fit Selection
window.

The table can be sorted by any cloumn other than Series Name by clicking on the
column heading.

Controls and Fields
Graph

brings up the Model Viewer window on the model currently selected in the table.

Stats
brings up theStatistics of Fit Selection window. This controls
the set of goodness-of-fit statistics displayed in the table and in other parts of the
Time Series Forecasting System.

Compare
brings up theModel Fit Comparison window for the series currently se-
lected in the table. This button is grayed out if the currently selected row in the
table represents a series for which fewer than two models have been fit.

Save
brings up an output data set dialog, enabling you to specify a SAS data set to
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which the contents of the table will be saved. Note that this operation saves what
you see in the table. If you want to save the models themselves for use in a future
session, use the Manage Projects window.

Print
prints the contents of the table, using current print settings of the Print Setup
window.

Close
closes the window and returns to the Automatic Model Fitting window.

Menu Bar
File

Save
brings up an output data set dialog, enabling you to specify a SAS data set
to which the contents of the table will be saved. This is the same as the
Save button.

Print
prints the contents of the table, using current print settings of the Print Setup
window. This is the same as thePrint button.

Import Data
is available if you license SAS/Access software. It brings up an Import
Wizard which you can use to import your data from an external spreadsheet
or data base to a SAS data set for use in the Time Series Forecasting System.

Export Data
is available if you license SAS/Access software. It brings up an Export
Wizard which you can use to export a SAS data set, such as a forecast
data set created with the Time Series Forecasting System, to an external
spreadsheet or data base.

Print Setup
brings up thePrint Setup window, which allows you to access your
operating system print setup or choose SAS/Graph print drivers.

Close
closes the window and returns to the Automatic Model Fitting window.

View

Model Predictions
brings up the Model Viewer to display a predicted and actual plot for the
currently highlighted model.

Prediction Errors
brings up the Model Viewer to display the prediction errors for the currently
highlighted model.

Prediction Error Autocorrelations
brings up the Model Viewer to display the prediction error autocorrelations,
partial autocorrelations, and inverse autocorrelations for the currently high-
lighted model.
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Prediction Error Tests
brings up the Model Viewer to display graphs of white noise and stationar-
ity tests on the prediction errors of the currently highlighted model.

Parameter Estimates
brings up the Model Viewer to display the parameter estimates table for the
currently highlighted model.

Statistics of Fit
brings up the Model Viewer window to display goodness-of-fit statistics for
the currently highlighted model.

Forecast Graph
brings up the Model Viewer to graph the forecasts for the currently high-
lighted model.

Forecast Table
brings up the Model Viewer to display forecasts for the currently high-
lighted model in a table.

Tools

Compare Models
brings up the Model Fit Comparison window to display fit statistics for
selected pairs of forecasting models. This item is grayed out until you select
a series in the table for which the automatic model fitting run selected two
or more models.

Options

Statistics of Fit
brings up the Statistics of Fit Selection window. This is the same as the
Stats button.

Column Labels
selects long or short column labels for the table. Long column labels are
used by default.

ID Columns
freezes or unfreezes the series and model columns. By default they are
frozen so that they remain visible when you scroll the table horizontally to
view other columns.

Automatic Model Selection Options Window

Use the Automatic Model Selection Options window to control the automatic selec-
tion process. This window is available from the Automatic Fit item of the Options
pull-down menu in the Develop Models window, Automatic Model Fitting window,
and Produce Forecasts window.

SAS OnlineDoc: Version 8
1372



Chapter 29. Window Reference

Controls and Fields
Models to fit

Subset by series diagnostics
when selected, causes the automatic model selection process to search only
over those models consistent with the series diagnostics.

All models in selection list
when selected, causes the automatic model selection process to search over
all models in the search list, without regard for the series diagnostics.

Models to keep
specifies how many of the models tried by the automatic model selection process
are retained and added to the model list for the series. You can specify the best
fitting model only, the bestn models, wheren can be 1 through 9, or all models
tried.

OK
closes the window and saves the automatic model selection options you speci-
fied.

Cancel
closes the window without changing the automatic model selection options.

Custom Model Specification Window

Use the Custom Model Specification window to specify and fit an ARIMA model
with or without predictor effects as inputs. Access it from the Develop Models win-
dow, where it is invoked from the Fit Model item under the Edit pull-down menu, or
from the pop-up menu when you click an empty area of the model table.
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Controls and Fields
Series

is the name and variable label of the current series.

Model
is a descriptive label for the model that you specify. You can type a label in this
field or allow the system to provide a label. If you leave the label blank, a label
is generated automatically based on the options you specify.

Transformation
defines the series transformation for the model. When a transformation is spec-
ified, the model is fit to the transformed series, and forecasts are produced by
applying the inverse transformation to the resulting forecasts. The available
transformations are

Log
specifies a logarithmic transformation.

Logistic
specifies a logistic transformation.

Square Root
specifies a square root transformation.

Box-Cox
specifies a Box-Cox transform and brings up a window to specify the Box-
Cox� parameter.

None
specifies no series transformation.

Trend Model
controls the model options to model and forecast the series trend. Select from

Linear Trend
adds a Linear Trend item to the Predictors list.
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Trend Curve
brings of a menu of different time trend curves and adds the curve you
select to the Predictors list.

First Difference
specifies differencing the series.

Second Difference
specifies second-order differencing of the series.

None
specifies no model for the series trend.

Seasonal Model
controls the model options to model and forecast the series seasonality. Select
from:

Seasonal ARIMA
brings up the Seasonal ARIMA Model Options window to enable you to
specify an ARIMA model for the seasonal pattern in the series.

Seasonal Difference
specifies differencing the series at the seasonal lag.

Seasonal Dummy Regressors
adds a Seasonal Dummies predictor item to the Predictors list.

None
specifies no seasonal model.

Error Model
displays the current settings of the autoregressive and moving average terms, if
any, for modeling the prediction error autocorrelation pattern in the series.

Set button
brings up theError Model Options window to let you set the autoregres-
sive and moving average terms for modeling the prediction error autocorrelation
pattern in the series.

Intercept
The optionsYes andNo enable you to specify whether a mean or intercept pa-
rameter is included in the model. By default, the Intercept option is set to No
when the model includes differencing and set to Yes when there is no differenc-
ing.

Predictors
is a list of the predictor effects included as inputs in the model.

OK
closes the Custom Model Specification window and fits the model.

Cancel
closes the Custom Model Specification window without fitting the model. Any
options you specified are lost.

Reset
resets all options to their initial values upon entry to the Custom Model Specifi-
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cation window. This may be useful when editing an existing model specification;
otherwise, Reset has the same function as Clear.

Clear
resets all options to their default values.

Add
brings up a menu of types of predictors to add to the Predictors list. Select from:

Linear Trend
adds a Linear Trend item to the Predictors list.

Trend Curve
brings up a menu of different time trend curves and adds the curve you
select to the Predictors list.

Regressors
brings up the Regressors Selection window to enable you to select other
series in the input data set as regressors to predict the dependent series and
add them to the Predictors list.

Adjustments
brings up the Adjustments Selection window to enable you to select other
series in the input data set for use as adjustments to the forecasts and add
them to the Predictors list.

Dynamic Regressor
brings up the Dynamic Regressor Selection window to enable you to select
a series in the input data set as a predictor of the dependent series and also
specify a transfer function model for the effect of the predictor series.

Interventions
brings up the Interventions for Series window to enable you to define and
select intervention effects and add them to the Predictors list.

Seasonal Dummies
adds a Seasonal Dummies predictor item to the Predictors list. This is
grayed out if the series interval is not one which has a seasonal cycle.

Delete
deletes the selected (highlighted) entry from the Predictors list.

Edit
edits the selected (highlighted) entry in the Predictors list.

Mouse Button Actions
You can select or deselect entries in the Predictors list by positioning the mouse cursor
over the entry and clicking the left mouse button. The selected (highlighted) predictor
effect is acted on by theDelete andEdit buttons. Double-clicking on a predictor
in the list invokes an appropriate edit action for that predictor.

If you position the mouse cursor over the Predictors list and press the right mouse
button, the system displays a menu of actions encompassing the features of theAdd,
Delete , andEdit buttons.

SAS OnlineDoc: Version 8
1376



Chapter 29. Window Reference

Data Set Selection Window

Use this resizable window to select a data set to process by specifying a library and
a SAS data set or view. These selections can be made by typing, by selecting from
lists, or by a combination of the two. In addition, you can control the time ID variable
and time interval, and you can browse the data set.

Access this window using the Browse button to the right of the Data Set field in the
Time Series Forecasting, Automatic Model Fitting, and Produce Forecasts windows.
It functions in the same way as the Series Selection window, except that it does not
allow you to select or view a time series variable.

Controls and Fields
Library

is a SAS libname assigned within the current SAS session. If you know the
libname associated with the data set of interest, you can type it in this field. If it
is a valid choice, it will appear in the libraries list and will be highlighted. The
SAS Data Sets list will be populated with data sets associated with that libname.
See alsoLibraries underSelection Lists.

Data Set
is the name of a SAS data set (data file or data view) that resides under the
selected libname. If you know the name, you can type it in and press Return. If it
is a valid choice, it will appear in the SAS Data Sets list and will be highlighted.

Time ID
is the name of the ID variable for the selected input data set. To specify the ID
variable, you can type the ID variable name in this field or select the control
arrows to the right of the field.

Time ID Select button
brings up the Time ID Variable Specification window.

Time ID Create button
brings up a menu of methods for creating a time ID variable for the input data
set. Use this feature if the data set does not already contain a valid time ID
variable.
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Interval
is the time interval between observations (data frequency) in the selected data
set. If the interval is not automatically identified by the system, you can type
in the interval name or select it from a list by clicking the combo box arrow.
For more information on intervals, see Chapter 3, “Date Intervals, Formats, and
Functions,” in this book.

OK
closes the Data Set Selection window and makes the selected data set the current
input data set.

Cancel
closes the window without applying any selections made.

Table
brings up a Viewtable window for browsing the selected data set.

Reset
resets the fields to their initial values upon entry to the window.

Refresh
updates all fields and lists on the window. If you assign a new libname with-
out exiting the Data Set Selection window, use the refresh action to update the
Libraries list so that it will include the newly assigned libname.

Selection Lists
Libraries

displays a list of currently assigned libnames. You can select a libname by click-
ing it with the left mouse button, which is equivalent to typing its name in the
Library field.

If you cannot locate the library or directory you are interested in, go to the SAS
Explorer window, selectNew from theFile pull-down menu, then select
Library and OK. This brings up theNew Library dialog window. You
also assign a libname by submitting alibname statement from the Program
window. Select theRefresh button to make the new libname available in the
libraries list.

SAS Data Sets
displays a list of the SAS data sets (data files or data views) contained in the
selected library. You can select one of these by clicking with the left mouse
button, which is equivalent to typing its name in the Data set field. You can
double-click on a data set name to select it and exit the window.

Default Time Ranges Window

Use the Default Time Ranges window to control how the period of fit and evaluation
and the forecasting horizon are determined for each series when you do not explicitly
set these ranges for a particular series. Invoke this window from the Options pull-
down menu of the Develop Models, Automatic Model Fitting, Produce Forecasts,
and Manage Forecasting Project windows. The settings you make in this window
affect subsequently selected series: They do not alter the time ranges of series you
have already selected.
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Controls and Fields
Forecast Horizon

specifies the forecast horizon as either a number of periods or years from the
last nonmissing data value or as a fixed date. You can type a number or date
value in this field. Date value must be entered in a form recognized by a SAS
date informat. (Refer toSAS Language Referencefor information on SAS date
informats.)

Forecast Horizon Units
indicates whether the value in the forecast horizon field represents periods or
years or a date. Click the arrow and choose one of these three options from the
popup list.

Hold-out Sample Size
specifies that a number of observations, number of years, or percent of the

data at the end of the data range be used for the period of evaluation with the
remainder of data used as the period of fit.

Hold-out Sample Size Units
indicates whether the hold-out sample size represents periods or years or percent
of data range.

Period of Fit
specifies how much of the data range for a series is to be used as the period of fit
for models fit to the series. ALL indicates that all the available data is used. You
can specify a number of periods, number of years, or a fixed date, depending on
the value of the units field to the right. When you specify a date, the start of the
period of fit is the specified date or the first nonmissing series value, whichever
is more recent. Date value must be entered in a form recognized by a SAS
date informat. (Refer toSAS Language Referencefor information on SAS date
informats.) When you specify the number of periods or years, the start of the
period of fit is computed as the date that number of periods or years from the
end of the data.

Period of Fit Units
indicates whether the period of fit value represents periods or years or a date.

OK
closes the window and stores the specified changes.

Cancel
closes the window without saving changes. Any options you specified are lost.

1379
SAS OnlineDoc: Version 8



Part 3. General Information

Defaults
resets all options to their default values.

Reset
resets the options to their initial values upon entry to the window.

Develop Models Window

This resizable window provides access to all of the Forecasting System’s interactive
model fitting and graphical tools. Use it to fit forecasting models to an individual
time series and choose the best model to use to produce the final forecasts of the
series. Invoke this window using theDevelop Models button on the Time Series
Forecasting window.

Controls and Fields
Data Set

is the name of the current input data set.

Interval
is the time interval (data frequency) for the input data set.

Series
is the variable name and label of the current time series.

Browse button
brings up the Series Selection window to enable you to change the current input
data set or series.

Data Range
is the date of the first and last nonmissing data values available for the current
series in the input data set.

Fit Range
is the current period of fit setting. This is the range of data that will be used to
fit models to the series.
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Evaluation Range
is the current period of evaluation setting. This is the range of data that will be
used to calculate the goodness-of-fit statistics for models fit to the series.

Set Ranges button
brings up the Time Ranges Specification window to enable you to change the fit
range or evaluation range. Note: A new fit range is applied when new models
are fit or when existing models are refit. A new evaluation range is applied when
new models are fit or when existing models are refit or reevaluated. Changing
the ranges does not automatically refit or reevaluate any models in the table: Use
the Refit Models or Reevaluate Models items under the Edit pull-down menu.

View Series Graphically icon
brings up the Time Series Viewer window to display plots of the current series.

View Selected Model Graphically icon
brings up the Model Viewer to display graphs and tables for the currently high-
lighted model.

Forecast Model
is the column of the model table that contains check boxes to select which model
is used to produce the final forecasts for the current series.

Model Title
is the column of the model table that contains the descriptive labels of the fore-
casting models fit to the current series.

Root Mean Square Error (or other statistic name) button
is the button above the right side of the table. It displays the name of the current
model selection criterion: A statistic that measures how well each model in the
table fits the values of the current series for observations within the evaluation
range. Clicking this button brings up theModel Selection Criterion
window to let you to select a different statistic. When you select a statistic, the
model table the Develop Models window is updated to show current values of
that statistic.

Menu Bar
File

New Project
brings up a dialog which lets you create a new project, assign it a name and
description, and make it the active project.

Open Project
brings up a dialog which lets you select and load a previously saved project.

Save Project
saves the current state of the system (including all the models fit to a series)
to the current project catalog entry.

Save Project as
saves the current state of the system with a prompt for the name of the
catalog entry in which to store the information.
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Clear Project
clears the system, deleting all the models for all series.

Save Forecast
writes forecasts from the currently highlighted model to an output data set.

Save Forecast As
prompts for an output data set name and saves the forecasts from the cur-
rently highlighted model.

Output Forecast Data Set
brings up a dialog for specifying the default data set used when you select
Save Forecast .

Import Data
is available if you license SAS/Access software. It brings up an Import
Wizard which you can use to import your data from an external spreadsheet
or data base to a SAS data set for use in the Time Series Forecasting System.

Export Data
is available if you license SAS/Access software. It brings up an Export
Wizard which you can use to export a SAS data set, such as a forecast
data set created with the Time Series Forecasting System, to an external
spreadsheet or data base.

Print Setup
brings up thePrint Setup window, which allows you to access your
operating system print setup or choose SAS/Graph print drivers.

Close
closes the Develop Models window and returns to the main window.

Edit

Fit Model

Automatic Fit
invokes the automatic model selection process.

Select From List
brings up the Models to Fit window.

Smoothing Model
brings up the Smoothing Model Specification window.

ARIMA Model
brings up the ARIMA Model Specification window.

Custom Model
brings up the Custom Model Specification window.

Combine Forecasts
brings up the Forecast Combination Model Specification window.

External Forecasts
brings up the External Forecast Model Specification window.

Edit Model
enables you to modify the specification of the currently highlighted model
in the table and fit the modified model. The new model replaces the current
model in the table.
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Delete Model
deletes the currently highlighted model from the model table.

Refit Models

All Models
refits all models in the table using data within the current fit range.

Selected Model
refits the currently highlighted model using data within the current fit
range.

Reevaluate Models

All Models
recomputes statistics of fit for all models in the table using data within
the current evaluation range.

Selected Model
recomputes statistics of fit for the currently highlighted model using
data within the current evaluation range.

View

Project
brings up the Manage Forecasting Project window.

Data Set
brings up a Viewtable window to display the current input data set.

Series
brings up the Time Series Viewer window to display plots of the current
series. This is the same as theView Series Graphically icon.

Model Predictions
brings up the Model Viewer to display a predicted versus actual plot for the
currently highlighted model. This is the same as theView Selected
Model Graphically icon.

Prediction Errors
brings up the Model Viewer to display the prediction errors for the currently
highlighted model.

Prediction Error Autocorrelations
brings up the Model Viewer to display the prediction error autocorrelations,
partial autocorrelations, and inverse autocorrelations for the currently high-
lighted model.

Prediction Error Tests
brings up the Model Viewer to display graphs of white noise and stationar-
ity tests on the prediction errors of the currently highlighted model.

Parameter Estimates
brings up the Model Viewer to display the parameter estimates table for the
currently highlighted model.

Statistics of Fit
brings up the Model Viewer window to display goodness-of-fit statistics for
the currently highlighted model.
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Forecast Graph
brings up the Model Viewer to graph the forecasts for the currently high-
lighted model.

Forecast Table
brings up the Model Viewer to display forecasts for the currently high-
lighted model in a table.

Tools

Diagnose Series
brings up the Series Diagnostics window to determine the kinds of fore-
casting models appropriate for the current series.

Define Interventions
brings up the Interventions for Series window to enable you to edit or add
intervention effects for use in modeling the current series.

Sort Models
sorts the models in the table by the values of the currently displayed fit

statistic.

Compare Models
brings up the Model Fit Comparison window to display fit statistics for
selected pairs of forecasting models. This is grayed out if there are fewer
than two models in the table.

Generate Data
brings up the Time Series Simulation window. This window enables you to
simulate ARIMA time series processes and is useful for educational exer-
cises or testing the system.

Options

Time Ranges
brings up the Time Ranges Specification window to enable you to change
the fit and evaluation time ranges and the forecast horizon. This action is
the same as theSet Ranges button.

Default Time Ranges
brings up the Default Time Ranges window to enable you to control how
the system sets the time ranges for series when you do not explicitly set
time ranges with the Time Ranges Specification window. Settings made
using this window do not affect series you are already working with, they
take effect when you select a new series.

Model Selection List
brings up the Model Selection List window. Use this action to edit the set
of forecasting models considered by the automatic model selection process
and displayed by the Models to Fit window.

Model Selection Criterion
brings up the Model Selection Criterion window, which presents a list of
goodness-of-fit statistics and enables you to select the fit statistic that is
displayed in the table and used by the automatic model selection process
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to determine the best fitting model. This action is the same as clicking
the button above the table which displays the name of the current model
selection criterion.

Statistics of Fit
brings up the Statistics of Fit Selection window, which presents a list of
statistics that the system can display. Use this action to customize the list of
statistics shown in the Model Viewer, Automatic Model Fitting Results, and
Model Fit Comparison windows and available for selection in the Model
Selection Criterion menu.

Forecast Options
brings up the Forecast Options window, which enables you to control the
widths of forecast confidence limits and control the kind of predicted values
computed for models that include series transformations.

Alignment of Dates

Beginning
aligns dates that the system generates to identify forecast observations
in output data sets to the beginning of the time intervals.

Middle
aligns dates that the system generates to identify forecast observations
in output data sets to the midpoints of the time intervals.

End
aligns dates that the system generates to identify forecast observations
in output data sets to the end of the time intervals.

Automatic Fit
brings up the Automatic Model Selection Options window, which enables
you to control the number of models retained by the automatic model se-
lection process and whether the models considered for automatic selection
are subset according to the series diagnostics.

Include Interventions
controls whether intervention effects defined for the current series are au-
tomatically added as predictors to the models considered by the automatic
selection process and displayed by theModels to Fit window. When
the Include Interventions option is selected, the series interventions are also
automatically added to the predictors list when you specify a model in the
ARIMA and Custom Models Specification windows. A check mark or
filled check box next to this item indicates that the option is turned on.
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Print Audit Trail
prints to the SAS log information about the models fit by the system. A

check mark or filled check box next to this item indicates that the audit
option is turned on.

Show Source Statements
Controls whether SAS statements submitted by the forecasting system are
printed in the SAS log. When the Show Source Statements option is se-
lected, the system sets the SAS system option SOURCE before submitting
SAS statements; otherwise, the system uses the NOSOURCE option. Note
that only some of the functions performed by the forecasting system are
accomplished by submitting SAS statements. A check mark or filled check
box next to this item indicates that the option is turned on.

Left Mouse Button Actions for the Model Table
When the cursor is over the description of a model in the table, the left mouse button
selects (highlights) or deselects that model. On some computer systems, you can
double-click to bring up the Model Viewer window for the selected model.

When the cursor is over an empty part of the model table, the left mouse button brings
up a menu of model fitting choices. These choices are the same as those in the Fit
Model submenu of the of the Edit pull-down menu.

Right Mouse Button Actions for the Model Table
When a model in the table is selected, the right mouse brings up a menu of actions
that apply to the highlighted model. The actions available in this menu are as follows.

View Model
brings up the Model Viewer for the selected model. This action is the same as
theView Model Graphically icon.

View Parameter Estimates
brings up the Model Viewer to display the parameter estimates table for the
currently highlighted model. This is the same as the Parameter Estimates item
in the View pull-down menu.

View Statistics of Fit
brings up the Model Viewer to display a table of goodness-of-fit statistics for the
currently highlighted model. This is the same as the Statistics of Fit item in the
View pull-down menu.

Edit Model
enables you to modify the specification of the currently highlighted model in the
table and fit the modified model. This is the same as the Edit Model item in the
Edit pull-down menu.

Refit Model
refits the highlighted model using data within the current fit range. This is the
same as the Selected Model item under the Refit Models submenu of the Edit
pull-down.
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Reevaluate Model
reevaluates the highlighted model using data within the evaluation fit range. This
is the same as the Selected Model item under the Reevaluate Models submenu
of the Edit pull-down.

Delete Model
deletes the currently highlighted model from the model table. This is the same
as the Delete Model item under the Edit pull-down menu.

View Forecasts
brings up the Model Viewer to display the forecasts for the currently highlighted
model. This is the same as the Forecast Graph item under the View pull-down
menu.

When the model list is empty or when no model is selected, the right mouse button
brings up the same menu of model fitting actions as the left mouse button.

Dynamic Regression Specification Window

Use the Dynamic Regression Specification window to specify a dynamic regression
or transfer function model for the effect of the predictor variable. It is invoked from
the Dynamic Regressors Selection window.

Controls and Fields
Series

is the name and variable label of the current series.

Input Model
is a descriptive label for the dynamic regression model. You can type a label in
this field or allow the system to provide the label. If you leave the label blank,
a label is generated automatically based on the options you specify. When no
options are specified, the label is the name and variable label of the predictor
variable.

Input Transformation
displays the transformation specified for the predictor variable. When a trans-
formation is specified, the transfer function model is fit to the transformed input
variable.
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Lagging periods
is the pure delay in the effect of the predictor,l.

Simple Order of Differencing
is the order of differencing,d. Set this field to 1 to use the changes in the pre-
dictor variable.

Seasonal Order of Differencing
is the order of seasonal differencing,D. Set this field to 1 to difference the pre-
dictor variable at the seasonal lags, for example, to use the year-over-year or
week-over-week changes in the predictor variable.

Simple Order Numerator Factors
is the order of the numerator factor of the transfer function,p.

Seasonal Order Numerator Factors
is the order of the seasonal numerator factor of the transfer function,P.

Simple Order Denominator Factors
is the order of the denominator factor of the transfer function,q.

Seasonal Order Denominator Factors
is the order of the seasonal denominator factor of the transfer function,Q.

OK
closes the window and adds the dynamic regression model specified to the model
predictors list.

Cancel
closes the window without adding the dynamic regression model. Any options
you specified are lost.

Reset
resets all options to their initial values upon entry to the window. This may
be useful when editing a predictor specification; otherwise, Reset has the same
function as Clear.

Clear
resets all options to their default values.

Dynamic Regressors Selection Window

Use the Dynamic Regressors Selection window to select an input variable as a dy-
namic regressor. Access this window from the pop-up menu which appears when
you select theAdd button of the ARIMA Model Specification window or Custom
Model Specification window.
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Controls and Fields
Dependent

is the name and variable label of the current series.

Dynamic Regressors
is a table listing the variables in the input data set. Select one variable in this list
as the predictor series.

OK
brings up the Dynamic Regression Specification window for you to specify the
form of the dynamic regression for the selected predictor series, and then closes
the Dynamic Regressors Selection window and adds the specified dynamic re-
gression to the model predictors list.

Cancel
closes the window without adding the dynamic regression model. Any options
you specified are lost.

Reset
resets all options to their initial values upon entry to the window.

Error Model Options Window

Use the Error Model Options window to specify the the autoregressive and mov-
ing average orders for the residual autocorrelation part of a model defined using the
Custom Model Specification window. Access it using theSet button of
that window.
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Controls and Fields
ARIMA Options

Use these combo boxes to specify the orders of the ARIMA model. You can
either type in a value or click the combo box arrow to select from a popup
list.

Autoregressive
defines the order of the autoregressive part of the model.

Moving Average
defines the order of the moving average term.

OK
closes the Error Model Options window and returns to theCustom Model
Specification window.

Cancel
closes the Error Model Options window and returns to theCustom Model
Specification window, discarding any changes made.

Reset
resets all options to their initial values upon entry to the window.

External Forecast Model Specification Window

Use the External Forecast Model Specification window to add to the current project
forecasts produced externally to the Time Series Forecasting System. To add an ex-
ternal forecast, select a variable from the selection list and choose the OK button. The
name of the selected variable will be added to the list of models fit, and the values
of this variable will be used as the forecast. For more information, seeIncorporating
Forecasts from Other Sourcesin theSpecifying Forecasting Modelschapter.
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Controls and Fields
OK

Closes the window and adds the external forecast to the project.

Cancel
Closes the window without adding an external forecast to the project.

Reset
Deselects any selection made in the selection list.

Forecast Combination Model Specification Window

Use the Forecast Combination Model Specification window to produce forecasts by
averaging the forecasts of two or more forecasting models. The specified combination
of models is added to the model list for the series. Access this window from the
Develop Models window whenever two or more models have been fit to the current
series. It is invoked by selecting Combine Forecasts from the Fit Model submenu of
the Edit pull-down, or from the pop-up menu which appears when you click an empty
part of the model table.
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Controls and Fields
Series

is the name and variable label of the current series.

Model
is a descriptive label for the model that you specify. You can type a label in this
field or allow the system to provide a label. If you leave the label blank, a label
is generated automatically based on the options you specify.

Weight
is a column of the forecasting model table that contains the weight values for
each model. The forecasts for the combined model are computed as a weighted
average of the predictions from the models in the table using these weights.
Models with missing weight values are not included in the forecast combination.
You can type weight values in these fields or you can use other features of the
window to set the weights.

Model Description
is a column of the forecasting model table that contains the descriptive labels of
the forecasting models fit to the current series that are available for combination.

Root Mean Square Error (or other statistic name) button
is the button above the right side of the table. It displays the name of the current
model selection criterion: A statistic that measures how well each model in the
table fits the values of the current series for observations within the evaluation
range. Clicking this button brings up theModel Selection Criterion
window to enable you to select a different statistic.

Normalize Weights button
replaces each nonmissing value in the Weights column with the current value
divided by the sum of the weights. The resulting weights are proportional to
original weights and sum to 1.

Fit Regression Weights button
computes weight values for the models in the table by regressing the series on the
predictions from the models. The values in the Weights column are replaced by
the estimated coefficients produced by this linear regression. If some weight val-
ues are nonmissing and some are missing, only models with nonmissing weight
values are included in the regression. If all weights are missing, all models are
used.

OK
closes the Forecast Combination Model Specification window and fits the model.

Cancel
closes the Forecast Combination Model Specification window without fitting the
model. Any options you specified are lost.

Reset
resets all options to their initial values upon entry to the Forecast Combination
Model Specification window. This may be useful when editing an existing model
specification; otherwise, Reset has the same function as Clear.

Clear
resets all options to their default values.
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Mouse Button Actions
You can select or deselect models for inclusion in the combination model by position-
ing the mouse cursor over the model description and pressing the left mouse button.
When you select a model in this way, the weights are automatically updated.

The newly selected model is given a weight equal to the average weight of the pre-
viously selected models, and all the nonmissing weights are normalized to sum to
1. When you use the mouse to remove a model from the combination, the weight
of the deselected model is set to missing and the remaining nonmissing weights are
normalized to sum to 1.

Forecasting Project File Selection Window

Use the Forecasting Project File Selection window to locate and load a previously
stored forecasting project. Access it from the project Browse button of the Manage
Forecasting Project window or the Time Series Forecasting Window or from the Open
Project item under the File pull-down of the Develop Models window.

Selection Lists
Libraries

is a list of currently assigned libraries. When you select a library from this list,
the catalogs in that library are shown in the catalog selection list.

Catalogs
is a list of catalogs contained in the currently selected library. When you select
a catalog from this list, any forecasting project entries stored in that catalog are
shown in the projects selection list.

Projects
is a list of forecasting project entries contained in the currently selected catalog.

Controls and Fields
OK

closes the window and opens the selected project.

Cancel
closes the window without selecting a project.

Reset
restores selections to those which were set before the window was opened.
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Forecast Options Window

Use the Forecast Options window to set options to control how forecasts and con-
fidence limits are computed. It is available from the Forecast Options item in the
Options pull-down menu of the Develop Models window, Automatic Model Fitting
window, Produce Forecasts, and Manage Projects windows.

Controls and Fields
Confidence Limits

specifies the size of the confidence limits for the forecast values. For example,
a value of .95 specifies 95% confidence intervals. You can type in a number or
select from the popup list.

Predictions for transformed models
These two options control how forecast values are computed for models that
employ a series transformation. See the section "Predictions for Transformed
Models" in Chapter 30, “Forecasting Process Details,”, for more information.
The values are as follows.

Mean
specifies that forecast values be predictions of the conditional mean of the
series.

Median
specifies that forecast values be predictions of the conditional median of
the series.

OK
closes the window and saves the option settings you specified.

Cancel
closes the window without changing the forecast options. Any options you spec-
ified are lost.

Intervention Specification Window

Use the Intervention Specification window to specify intervention effects to model
the impact on the series of unusual events. Access it from the Intervention for Series
window. For more information, seeInterventionsin the Using Predictor Variables
section.

SAS OnlineDoc: Version 8
1394



Chapter 29. Window Reference

Controls and Fields
Series

is the name and variable label of the current series.

Label
is a descriptive label for the intervention effect that you specify. You can type a
label in this field or allow the system to provide the label. If you leave the label
blank, a label is generated automatically based on the options you specify.

Date
is the date that the intervention occurs. You can type a date value in this field, or
you can set the date by selecting a row of the data table on the right side of the
window.

Type of Intervention

Point
specifies that the intervention variable is zero except for the specified date.

Step
specifies that the intervention variable is zero before the specified date and
a constant 1.0 after the date.

Ramp
specifies that the intervention variable is an increasing linear function of
time after the date of the intervention and zero before the intervention date.

Number of lags
specifies the numerator order for the transfer function model for the intervention
effect. Select a value from the popup list.

Effect Decay Pattern
specifies the denominator order for the transfer function model for the interven-
tion effect. The valueExp specifies a single lag denominator factor; the value
Wavespecifies a two lag denominator factor.
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OK
closes the window and adds the intervention effect specified to the series inter-
ventions list.

Cancel
closes the window without adding the intervention. Any options you specified
are lost.

Reset
resets all options to their initial values upon entry to the window. This may be
useful when editing an intervention specification; otherwise, Reset has the same
function as Clear.

Clear
resets all options to their default values.

Interventions for Series Window

Use the Interventions for Series window to create and edit a list of intervention ef-
fects to model the impact on the series of unusual events and to select intervention
effects as predictors for forecasting models. Access it from theAdd button pop-up
menu of the ARIMA Model Specification or Custom Model Specification window, or
by selectingDefine Interventions from the Tools pull-down in the Develop
Models window. For more information, seeInterventionsin Chapter 27, “Using Pre-
dictor Variables.”
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Controls and Fields
Series

is the name and variable label of the current series.

OK
closes the window. If you access this window from the ARIMA Model Speci-
fication window or the Custom Model Specification window, any interventions
which are selected (highlighted) in the list are added to the model. If you ac-
cess this window from the Tools pull-down menu, all interventions in the list are
saved for the current series.

Cancel
closes the window without returning a selection or changing the interventions
list. Any options you specified are lost.

Reset
resets the list as it was on entry to the window.

Clear
deletes all interventions from the list.

Add
brings up the Intervention Specification window to specify a new intervention
effect and add it to the list.

Delete
deletes the currently selected (highlighted) entries from the list.

Edit
brings up the Intervention Specification window to edit the currently selected
(highlighted) intervention.

Mouse Button Actions
To select or deselect interventions, position the mouse cursor over the intervention’s
label in the Interventions list and press the left mouse button.
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When you position the mouse cursor in the Interventions list and press the right mouse
button, a menu containing the actions Add, Delete, and Edit appears. These actions
are the same as theAdd, Delete , andEdit buttons.

Double-clicking on an intervention in the list invokes an Edit action for that interven-
tion specification.

Manage Forecasting Project Window

Use this resizable window to work with collections of series, models, and options
calledprojects. It consists of project name and description fields and a table of infor-
mation about all the series for which you have fit forecasting models. Access it using
theManage Projects button on the Time Series Forecasting window.

Controls and Fields
Project Name

is the name of the SAS catalog entry in which forecasting models and other
results will be stored and from which previously stored results are loaded into
the forecasting system. You can specify the project by typing a SAS catalog
entry name in this field or by selecting the Browse button to the right of this
field. If you specify the name of an existing catalog entry, the information in
the project file is loaded. If you specify a one level name, it is assumed to be
the name of a project in thefmsprojcatalog in thesasuserlibrary. For example,
typing samprojis equivalent to typingsasuser.fmsproj.samproj.

projectBrowse button
brings up the Forecasting Project File Selection window to enable you to select
and load the project from a list of previously stored project files.

Description
is a descriptive label for the forecasting project. The description you type in this
field will be stored with the catalog entry shown in the Project field if you save
the project.
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Series List Table
The table of series for which forecasting models have been fit contains the following
columns.

Series Name
is the name of the time series variable represented in the given row of the table.

Series Frequency
is the time interval (data frequency) for the time series.

Input Data Set Name
is the input data set that provided the data for the series.

Forecasting Model
is the descriptive label for the forecasting model selected for the series.

Statistic Name
is the statistic of fit for the forecasting model selected for the series.

Number of Models
is the total number of forecasting models fit to the series. If there is more than
one model for a series, use the Model List window to see a list of models.

Series Label
is the variable label for the series.

Time ID Variable Name
is the time ID variable for the input data set for the series.

Series Data Range
is the time range of the nonmissing values of the series.

Model Fit Range
is the period of fit used for the series.

Model Evaluation Range
is the evaluation period used for the series.

Forecast Range
is the forecast period set for the series.

Menu Bar
File

New
brings up a dialog which lets you create a new project, assign it a name and
description, and make it the active project.

Open
brings up a dialog which lets you select and load a previously saved project.

Close
closes the Manage Forecasting Project window and returns to the main win-
dow.

Save
saves the current state of the system (including all the models fit to a series)
to the current project catalog entry.
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Save As
saves the current state of the system with a prompt for the name of the
catalog entry in which to store the information.

Save to Data Set
saves the current project file information in a SAS data set. The contents
of the data set are the same as the information displayed in the series list
table.

Import Data
is available if you license SAS/Access software. It brings up an Import
Wizard which you can use to import your data from an external spreadsheet
or data base to a SAS data set for use in the Time Series Forecasting System.

Export Data
is available if you license SAS/Access software. It brings up an Export
Wizard which you can use to export a SAS data set, such as a forecast
data set created with the Time Series Forecasting System, to an external
spreadsheet or data base.

Print
prints the current project file information.

Print Setup
brings up thePrint Setup window, which allows you to access your
operating system print setup or choose SAS/Graph print drivers.

Edit

Delete Series
deletes all models for the selected (highlighted) row of the table and re-
moves the series from the project.

Clear
resets the system, deleting all series and models from the project.

Reset
restores the Manage Forecasting Project window to its initial state.

View

Data Set
brings up a Viewtable window to display the input data set for the selected
(highlighted) series.

Series
brings up the Time Series Viewer window to display plots of the selected
(highlighted) series.

Model
brings up the Model Viewer window to show the current forecasting model
for the selected series.

Forecast
brings up the Model Viewer to display plots of the forecasts produced by
the forecasting model for the selected (highlighted) series.
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Tools

Diagnose Series
brings up the Series Diagnostics window to perform the automatic series
diagnostic process to determine the kinds of forecasting models appropriate
for the selected (highlighted) series.

List Models
brings up the Model List window for the selected (highlighted) series,
which displays a list of all the models that you fit for the series. This action
is the same as double-clicking the mouse on the table row.

Generate Data
brings up the Time Series Simulation window. This window enables you to
simulate ARIMA time series processes and is useful for educational exer-
cises or testing the system.

Refit Models

All Series
refits all the models for all the series in the project using data within
the current fit range.

Selected Series
refits all the models for the currently highlighted series using data
within the current fit range.

Reevaluate Models

All Series
reevaluates all the models for all the series in the project using data
within the current evaluation fit range.

Selected Series
reevaluates all the models for the currently highlighted series using
data within the current evaluation range.

Options

Time Ranges
brings up the Time Ranges Specification window to enable you to change
the fit and evaluation time ranges and the forecast horizon.

Default Time Ranges
brings up the Default Time Ranges window to enable you to control how
the system sets the time ranges for series when you do not explicitly set
time ranges with the Time Ranges Specification window. Settings made
using this window do not affect series you are already working with–they
take effect when you select a new series.

Model Selection List
brings up the Model Selection List window. Use this to edit the set of
forecasting models considered by the automatic model selection process
and displayed by the Models to Fit window.
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Statistics of Fit
brings up the Statistics of Fit Selection window, which controls which of
the available statistics will be displayed.

Forecast Options
brings up the Forecast Options window, which enables you to control the
widths of forecast confidence limits and control the kind of predicted values
computed for models that include series transformations.

Column Labels
enables you to set long or short column labels. Long labels are used by
default.

Include Interventions
controls whether intervention effects defined for the current series are au-
tomatically added as predictors to the models considered by the automatic
selection process and displayed by the Model Selection List window. When
the Include Interventions option is selected, the series interventions are also
automatically added to the predictors list when you specify a model in the
ARIMA and Custom Models Specification windows.

Print Audit Trail
prints to the SAS log information about the models fit by the system. A
check mark or filled check box next to this item indicates that the audit
option is turned on.

Show Source Statements
controls whether SAS statements submitted by the forecasting system are
printed in the SAS log. When the Show Source Statements option is se-
lected, the system sets the SAS system option SOURCE before submitting
SAS statements; otherwise, the system uses the NOSOURCE option. Note
that only some of the functions performed by the forecasting system are
accomplished by submitting SAS statements. A check mark or filled check
box next to this item indicates that the option is turned on.

Left Mouse Button Actions
If you select a series in the table by positioning the cursor over the table row and
clicking with the left mouse button once, that row of the table is highlighted. Menu
bar actions such as Delete Series will apply to the highlighted row of the table.

If you select a series in the table by positioning the cursor over the table row and
double-clicking with the left mouse button, the system brings up the Model List win-
dow for that series, which displays a list of all the models that you fit for the series.
This is the same as the List Models action under Tools in the menu bar.

Right Mouse Button Actions
Clicking the right mouse button invokes a pop-up menu of actions applicable to the
highlighted series. The actions in this menu are as follows.

Delete Series
deletes the highlighted series and its models from the project. This is the same
as Delete Series in the Edit pull-down menu.
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Refit All Models
refits all models attached to the highlighted series using data within the current
fit range. This is the same as the Selected Series item under Refit Models in the
Tools pull-down menu.

Reevaluate All Models
reevaluates all models attached to the highlighted series using data within the
current evaluation range. This is the same as the Selected Series item under
Reevaluate Models in the Tools pull-down menu.

List Models
invokes the Model List window. This is the same as List Models under the Tools
pull-down menu.

View Series
brings up the Time Series Viewer window to display plots of the highlighted
series. This is the same asSeries in the View pull-down menu.

View Forecasting Model
invokes the Model Viewer window to display the forecasting model for the high-
lighted series. This is the same asModel in the View pull-down menu.

View Forecast
brings up the Model Viewer window to display the forecasts for the highlighted
series. This is the same asForecast in the View pull-down menu.

Refresh
updates information shown in the Manage Forecasting Project window.

Model Fit Comparison Window

Use the Model Fit Comparison window to compare goodness-of-fit statistics for any
two models fit to the current series. Access it from the Tools pull-down menu of the
Develop Models window and the Automatic Model Fitting Results window whenever
two or more models have been fit to the series.
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Controls and Fields
Series

identifies the current time series variable.

Range
displays the starting and ending dates of the series data range.

Model 1
shows the model currently identified as Model 1.

Model 1 upward arrow button
enables you to change the model identified as Model 1 if it is not already the first
model in the list of models associated with the series. Select this button to cycle
upward through the list of models.

Model 1 downward arrow button
enables you to change the model identified as Model 1 if it is not already the last
model in the list of models. Select this button to cycle downward through the
list of models.

Model 2
shows the model currently identified as Model 2.

Model 2 upward arrow button
enables you to change the model identified as Model 2 if it is not already the first
model in the list of models associated with the series. Select this button to cycle
upward through the list of models.

Model 2 downward arrow button
enables you to change the model identified as Model 2 if it is not already the last
model in the list of models. Select this button to cycle downward through the
list of models.

Close
closes the Model Fit Comparison window.

Save
brings up a dialog for specifying the name and label of a SAS data set to which
the statistics will be saved. The data set will contain all available statistics and
their values for Model 1 and Model 2, as well as a flag variable that is set to 1
for those statistics that were displayed.

Print
prints the contents of the table to the SAS Output window. If you find that the
contents do not appear immediately in the Output window, you will need to set
scrolling options. SelectPreferences under the Options submenu of the
Tools pull-down. In the Preferences window, select the Advanced tab, then set
output scroll lines to a number greater than zero.

If you want to route the contents to a printer, go to the Output window and select
Print from the File pull-down menu.

Statistics
brings up the Statistics of Fit Selection window for controlling which statistics
are displayed.
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Model List Window

This resizable window shows all of the models that have been fit to a particular series
in a project. Access it from the Manage Forecasting Project window by selecting a
series in the series list table and choosingList Models from the Tools pull-down
menu or by double-clicking the series.

Controls and Fields
Data Set

is the name of the current input data set.

Interval
is the time interval (data frequency) for the input data set.

Series
is the variable name and label of the current time series.

Data Range
is the date of the first and last nonmissing data values available for the current
series in the input data set.

Fit Range
is the current period of fit setting. This is the range of data that will be used to fit
models to the series. It may be different from the fit ranges shown in the table,
which were in effect when the models were fit.

Evaluation Range
is the current period of evaluation setting. This is the range of data that will be
used to calculate the goodness-of-fit statistics for models fit to the series. It may
be different from the evaluation ranges shown in the table, which were in effect
when the models were fit.

View Series Graphically icon
brings up the Time Series Viewer window to display plots of the current series.
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View Model Graphically icon
brings up the Model Viewer to display graphs and tables for the currently high-
lighted model.

Model List Table
The table of models fit to the series contains columns showing the model label, the
fit range and evaluation range used to fit the models, and all of the currently selected
fit statistics. You can change the selection of fit statistics using the Statistics of Fit
Selection window.

Click on column headings to sort the table by a particular column. If a model is
highlighted, clicking with the right mouse button invokes a pop-up menu providing
actions applicable to the highlighted model. It includes the following items.

View Model
brings up the Model Viewer on the selected model. This is the same asModel
Predictions under the View pull-down menu.

View Parameter Estimates
brings up the Model Viewer to display the parameter estimates table for the
currently highlighted model. This is the same asParameter Estimates
under the View pull-down menu.

View Statistics of Fit
brings up the Model Viewer to display the statistics of fit table for the currently
highlighted model. This is the same asStatistics of FIt under the View
pull-down menu.

Edit Model
brings up the appropriate model specification window for changing the attributes
of the highlighted model and fitting the modified model.

Refit Model
refits the highlighted model using the current fit range.

Reevaluate Model
reevaluates the highlighted model using the current evaluation range.

Delete Model
deletes the highlighted model from the project.

View Forecasts
brings up the Model Viewer to show the forecasts for the highlighted model.
This is the same asForecast Graph under the View pull-down menu.

Menu Bar
File

Save
brings up a dialog which lets you save the contents of the table to a specified
SAS data set.
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Import Data
is available if you license SAS/Access software. It brings up an Import
Wizard which you can use to import your data from an external spreadsheet
or data base to a SAS data set for use in the Time Series Forecasting System.

Export Data
is available if you license SAS/Access software. It brings up an Export
Wizard which you can use to export a SAS data set, such as a forecast
data set created with the Time Series Forecasting System, to an external
spreadsheet or data base.

Print
sends the contents of the table to a printer as defined through Print Setup.

Print Setup
brings up thePrint Setup window, which allows you to access your
operating system print setup or choose SAS/Graph print drivers.

Close
closes the window and returns to the Manage Forecasting Projects window.

Edit

Edit Model
enables you to modify the specification of the currently highlighted model
in the table and fit the modified model. The new model replaces the current
model in the table.

Refit Model
refits the currently highlighted model using data within the current fit range.

Reevaluate Model
recomputes statistics of fit for the currently highlighted model using data
within the current evaluation range.

Delete Model
deletes the currently highlighted model from the model table.

Reset
restores the contents of the Model List window to the state initially dis-
played.

View

Series
brings up the Time Series Viewer window to display plots of the current
series. This is the same as theView Series Graphically icon.

Model Predictions
brings up the Model Viewer to display a predicted and actual plot for
the currently highlighted model. This is the same as theView Model
Graphically icon.

Prediction Errors
brings up the Model Viewer to display the prediction errors for the currently
highlighted model.
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Prediction Error Autocorrelations
brings up the Model Viewer to display the prediction error autocorrelations,
partial autocorrelations, and inverse autocorrelations for the currently high-
lighted model.

Prediction Error Tests
brings up the Model Viewer to display graphs of white noise and stationar-
ity tests on the prediction errors of the currently highlighted model.

Parameter Estimates
brings up the Model Viewer to display the parameter estimates table for the
currently highlighted model.

Statistics of Fit
brings up the Model Viewer window to display goodness-of-fit statistics for
the currently highlighted model.

Forecast Graph
brings up the Model Viewer to graph the forecasts for the currently high-
lighted model.

Forecast Table
brings up the Model Viewer to display forecasts for the currently high-
lighted model in a table.

Options

Statistics of Fit
brings up the Statistics of Fit Selection window, which presents a list of
statistics that the system can display. Use this action to customize the list of
statistics shown in the Model Viewer, Automatic Model Fitting Results, and
Model Fit Comparison windows and available for selection in the Model
Selection Criterion menu.

Column Labels
enables you to set long or short column labels. Long labels are used by
default.

Model Selection Criterion Window

Use the Model Selection Criterion window to select the model selection criterion
statistic used by the automatic selection process to determine the best fitting fore-
casting model. Model selection criterion statistics are a subset of those shown in
the Statistics of Fit Selection window, since some statistics of fit, such as number of
observations, are not useful for model selection.

This window is available from the Model Selection Criterion item of the Options
pull-down menu of the Develop Models window, Automatic Model Fitting window,
and Produce Forecasts window.
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Controls and Fields
Show subset

when selected, lists only those model selection criterion statistics which are se-
lected in the Statistics of Fit Selection window.

Show all
when selected, lists all available model selection criterion statistics.

OK
closes the window and sets the model selection criterion to the statistic you spec-
ified.

Cancel
closes the window without changing the model selection criterion.

Model Selection List Window

Use the Model Selection List window to edit the model selection list, including
adding your own custom models, and to specify which models in the list are to be
used in the automatic fitting process. Access it from the Options pull-down menu
in the Develop Models, Automatic Model Fitting Window, Produce Forecasts, and
Manage Projects windows.

If you want to reuse any edited model selection list in future sessions, save the project.
When you reload the project file, your customized model selection list will be avail-
able. If you want the edited model list to be used as the default for new projects, use
theSet Current List as Default option (seeActions , which follows).
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Model Table
This table displays the descriptions of all models in the model selection list. You
can select one or more models by clicking them with the left mouse button. Selected
models are highlighted and become the object of the actions Edit, Move, and Delete.

The auto fit column of check boxes enables you to eliminate some of the models from
being used in the automatic fitting process without having to delete them from the
list. By default, all models are checked, meaning that they are all used for automatic
fitting.

Controls and Fields
Actions

brings up a pop-up menu of actions that can be applied to the model list. These
actions include:

Delete
deletes any highlighted models from the list. This item is not available if
no models are selected.

Move
enables you to reorder the models in the list. Select one or more models,
then select Move from the pop-up menu. A note appears on the message
line: "Select the row after which the selected models are to be moved."
Then select any unhighlighted row in the table. The selected models will
be moved after this row.

Edit
brings up the appropriate model specification window for changing the at-
tributes of the highlighted model and adding the modified model to the
selection list. The original model is not deleted. Since this is a generic tool
and does not associate the models with any particular data set, you cannot
specify particular variables as predictors. Items in the model specification
windows that involve designating variables from a data set are therefore not
available when invoked from the Model Selection List window.
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Add
enables you to add new models to the selection list. This is the same as
the edit action, except that instead of modifying existing model attributes,
you begin from scratch and are given a choice of using the Smoothing
Model Specification window, the ARIMA Model Specification window, or
the Custom Model Specification window.

Select All
selects all models in the list.

Unselect All
deselects all models in the list.

Select All-Autofit
checks the autofit check boxes of all models in the list.

Unselect All-Autofit
deselects the autofit check boxes of all models in the list.

Set Current List as Default
saves your edited model list as a default list for new projects. The loca-
tion of this saved list is shown on the message line. When you create new
projects, the system searches for this model list and uses it if it is found. If
it is not found, the system uses the original default model list supplied with
the product.

Open Original Default List
opens the default model list supplied with the product. Open this list
and clickOKto establish the original default list as the model list for the
current project. If you have previously used theSet Current List
as Default option to change the default model list and wish to revert
to the original defaults, selectOpen Original Default List and
then selectSet Current List as Default .

OK
closes the window and applies any changes made to the project’s model selection
list.

Cancel
exits the window and discards any changes made.

Refresh
restores the list to its initial state when the window was invoked.

Default
restores the default model selection list supplied with the software.

Mouse Button Actions
Selecting any model description in the table with the left mouse button selects (high-
lights) that model. Selecting the same model again deselects it. Multiple selections
are allowed.

Selecting the auto fit check box in any row toggles the associated model’s eligibility
for use in automatic model fitting.
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Selecting the right mouse button brings up a pop-up menu. This is equivalent to using
theActions button.

Model Viewer Window

This resizable window provides plots and tables of actual values, model predictions,
forecasts, and related statistics. The various plots and tables available are referred
to asviews. The followingView Selection Iconssection explains how to change the
view.

You can access Model Viewer in a number of ways, including theView Model
Graphically icon of the Develop Models and Model List windows, theGraph
button of the Automatic Model Fitting Results window, and the Model item under
the View pull-down in the Manage Foreasting Project window. In addition, you can
go directly to a selected view in the Model Viewer window by selecting Model Pre-
dictions, Prediction Errors, Statistics of Fit, Prediction Error Autocorrelations, Pre-
diction Error Tests, Parameter Estimates, Forecast Graph, or Forecast Table from the
View pull-down menu or corresponding toolbar icon or popup menu item in the De-
velop Models, Model List, or Automatic Model Fitting Results windows.

The state of the Model Viewer window is controlled by the current model and the
currently selected view. You can resize this window, and you can use other windows
without closing the Model Viewer window. By default, the Model Viewer window is
automatically updated to display the new model when you switch to working with an-
other model (that is, when you highlight a different model). You can unlink the Model
Viewer window from the current model selection by selecting theLink/Unlink
from the window’s horizontal tool bar. SeeLink/Unlink underTool Bar Icons.

For more information, seeModel Viewerin theGetting Startedsection.

Tool Bar Icons
The Model Viewer window contains a horizontal row of icons called the Tool Bar.
Corresponding menu items appear under various pull-down menus. The function of
each icon is explained in the following list.
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Zoom in
In the Model Predictions, Prediction Errors, and Forecast Graph views, the
Zoom In action changes the mouse cursor into cross hairs that you can use with
the left mouse button to define a region of the graph to zoom in on. In the Predic-
tion Error Autocorrelations and Prediction Error Tests views, Zoom In reduces
the number of lags displayed.

Zoom out
reverses the previous Zoom In action.

Link/Unlink viewer
disconnects or connects the Model Viewer window to the model table (Develop
Models window, Model List window, or Automatic Model Fitting Results win-
dow). When the viewer is linked, selecting another model in the model table
causes the model viewer to be updated to show the selected model. When the
Viewer is unlinked, selecting another model does not affect the viewer. This fea-
ture is useful for comparing two or more models graphically. You can display
a model of interest in the Model Viewer, unlink it, then select another model
and bring up another Model Viewer window for that model. Position the viewer
windows side by side for convenient comparisons of models, or use theNext
Viewericon or F12 function key to switch between them.

Save
saves the contents of the Model Viewer window. If the display contains a graph,
output is written to a SAS/GRAPHgrseg catalog entry. This is the same as
the Save Graph action under File in the menu bar. You can open the saved
entry using the SAS Explorer. This brings up a graph window from which you
can export to a number of external graphics formats by selectingExport as
Image from the File pull-down window.

If the display contains a table, output is written to a SAS data set (same as the
Save Data action under File in the menu bar). You will be prompted for the
output destination if none has been specified.

Print
prints the contents of the viewer window.

Close
closes the Model Viewer window and returns to the window from which it was
invoked.

View Selection Icons
At the right hand side of the Model Viewer window is a vertical tool bar to select the
view, that is, the kind of plot or table that the viewer displays. Corresponding menu
items appear under View in the menu bar. The function of each icon is explained in
the following list.

Model Predictions
displays a plot of actual series values and model predictions over time. Click on
individual points in the graph to get a display of the type (actual or predicted),
ID value, and data value in the upper right corner of the window.
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Prediction Errors
displays a plot of model prediction errors (residuals) over time. Click individual
points in the graph to get a display of the prediction error value in the upper right
corner of the window.

Prediction Error Autocorrelations
displays horizontal bar charts of the sample autocorrelation, partial autocorre-
lation, and inverse autocorrelation functions for the model prediction errors.
Overlaid line plots represent confidence limits computed at plus and minus two
standard errors. Click on any of the bars to display its value.

Prediction Error Tests
displays horizontal bar charts representing results of white noise and stationarity
tests on the model prediction errors. The first bar chart shows the significance
probability of the Ljung-Box chi-square statistic computed on autocorrelations
up to the given lag. Longer bars favor rejection of the null hypothesis that the
series is white noise. Click on any of the bars to display an interpretation.

The second bar chart shows tests of stationarity of the model prediction errors,
where longer bars favor the conclusion that the series is stationary. Each bar dis-
plays the significance probability of the augmented Dickey-Fuller unit root test
to the given autoregressive lag. Long bars represent higher levels of significance
against the null hypothesis that the series contains a unit root. For seasonal data,
a third bar chart appears for seasonal root tests. Click on any of the bars to
display an interpretation.

Parameter Estimates
displays a table showing model parameter estimates along with standard errors
andt-tests for the null hypothesis that the parameter is zero.

Statistics of Fit
displays a table of statistics of fit for the selected model. The set of statistics
shown can be changed using the Statistics of Fit item under Options in the menu
bar.

Forecast Graph
displays a plot of actual and predicted values for the series data range, followed
by a horizontal reference line and forecasted values with confidence limits. Click
on individual points in the graph to get a display of the type, date/time, and value
of the data point in the upper right corner of the window.

Forecast Table
displays a data table with columns containing the date/time, actual, predicted,
error (residual), lower confidence limit, and upper confidence limit values, to-
gether with any predictor series.

Menu Bar
File

Save Graph
saves the plot displayed in viewer window as a SAS/GRAPHgrseg cata-
log entry. When the current view is a table, this menu item is not available.
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See alsoSaveunderTool Bar Icons. If a graphics catalog entry name has
not already been specified, this action functions likeSave Graph As .

Save Graph As
saves the plot displayed in viewer window as a SAS/GRAPH GRSEG cata-
log entry that you specify. When the current view is a table, this menu item
is not available.

Save Data
saves the data displayed in the viewer window in an output SAS data, where
applicable.

Save Data As
brings up the Output Data Set window, then saves the contents of the viewer
window in the specified SAS data set, where applicable.

Import Data
is available if you license SAS/Access software. It brings up an Import
Wizard which you can use to import your data from an external spreadsheet
or data base to a SAS data set for use in the Time Series Forecasting System.

Export Data
is available if you license SAS/Access software. It brings up an Export
Wizard which you can use to export a SAS data set, such as a forecast
data set created with the Time Series Forecasting System, to an external
spreadsheet or data base.

Print Graph
prints the contents of the viewer window if the current view is a graph.
This is the same as the Print tool bar icon. If the current view is a table, this
menu item is not available.

Print Data
prints the data displayed in the viewer window, where applicable.

Print Setup
brings up thePrint Setup window, which allows you to access your
operating system print setup or choose SAS/Graph print drivers.

Print Preview
brings up a preview window to show how your plots will appear when
printed. This item is grayed out ifUse host driversis not selected in the
Print Setupwindow.

Close
closes the Model Viewer window and returns to the window from which it
was invoked.

Edit

Edit Model
enables you to modify the specification of the current model and to fit the
modified model, which is then displayed in the viewer.

Refit Model
refits the current model using data within the current fit range. This action
also causes the ranges to be reset if the data range has changed.
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Reevaluate Model
reevaluates the current model using data within the current evaluation
range. This action also causes the ranges to be reset if the data range has
changed.

View
See theView Selection Iconssection. It describes each of the items available
underView, exceptZoom Way Out.

Zoom Way Out
zooms the plot out as far as it will go, undoing all prior zoom in operations.

Tools

Link Viewer
SeeLink/Unlink underTool Bar Icons.

Options

Time Ranges
brings up the Time Ranges Specification window to enable you to change
the period of fit, period of evaluation, or forecast horizon to be applied to
subsequently fit models.

Statistics of Fit
brings up the Statistics of Fit Selection window, which presents a list of
statistics that the system can display. Use this action to customize the list
of statistics shown in the statistics of fit table and available for selection in
the Model Selection Criterion menu.

Forecast Options
brings up the Forecast Options window, which enables you to control the
widths of forecast confidence limits and control the kind of predicted values
computed for models that include series transformations.

Residual Plot Options
Provides a choice of four methods of computing prediction errors for mod-
els which include a data transformation.

Prediction Errors
computes the difference between the transformed series actual values
and model predictions.

Normalized Prediction Errors
computes prediction errors in normalized form.

Model Residuals
computes the difference between the untransformed series values and
the untransformed model predictions.

Normalized Model Residuals
computes model residuals in normalized form.

Number of Lags
brings up a window to enable you to specify the number of lags shown
in the Prediction Error Autocorrelations and Prediction Error Tests views.
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You can also use the Zoom In and Zoom Out actions to control the number
of lags displayed.

Correlation Probabilities
controls whether the bar charts in the Prediction Error Autocorrelations
view represent significance probabilities or values of the correlation coef-
ficient. A check mark or filled check box next to this item indicates that
significance probabilities are displayed. In each case the bar graph hori-
zonal axis label changes accordingly.

Include Interventions
controls whether intervention effects defined for the current series are au-
tomatically added as predictors to the models considered by the automatic
selection process. A check mark or filled check box next to this item indi-
cates that the option is turned on.

Print Audit Trail
prints to the SAS log information about the models fit by the system. A
check mark or filled check box next to this item indicates that the audit
option is turned on.

Show Source Statements
controls whether SAS statements submitted by the forecasting system are
printed in the SAS log. When the Show Source Statements option is se-
lected, the system sets the SAS system option SOURCE before submitting
SAS statements; otherwise, the system uses the NOSOURCE option. Note
that only some of the functions performed by the forecasting system are
accomplished by submitting SAS statements. A check mark or filled check
box next to this item indicates that the option is turned on.

Mouse Button Actions
You can examine the data values of individual points in the Model Predictions, Model
Prediction Errors, and Forecast Graph views of the Model Viewer by positioning the
mouse cursor over the point and clicking the left mouse button. The date/time and
data values as well as the type (actual, predicted, and so forth) are displayed in a
box that appears in the upper right corner of the Viewer window. Click the mouse
elsewhere or select any action to dismiss the data box.

Similarly, you can display values in the Prediction Error Autocorrelations view by
clicking on any of the bars. Clicking on bars in the Prediction Error Tests view
displays aRecommendation for Current View window which explains the
test represented by the bar.

When you select the Zoom In action in the Predicted Values, Model Prediction Errors,
and Forecasted Values views, you can use the mouse to define a region of the graph
to zoom. Position the mouse cursor at one corner of the region, press the left mouse
button, and move the mouse cursor to the opposite corner of the region while holding
the left mouse button down. When you release the mouse button, the plot is redrawn
to show an expanded view of the data within the region you selected.
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Models to Fit Window

Use the Models to Fit window to fit models by choosing them from the current model
selection list. Access it usingFit Models from List under the Fit Model sub-
menu of the Edit pull-down in the Develop Models window, or the pop-up menu
which appears when you click an empty area of the model table in the Develop Mod-
els window. If you want to alter the list of models which appears here, use the Model
Selection List window.

To select a model to be fit, use the left mouse button. To select more than one model
to fit, drag with the mouse, or select the first model, then press the shift key while
selecting the last model. For noncontiguous selections, press the control key while
selecting with the mouse. To begin fitting the models, double-click the last selection
or select theOKbutton.

If series diagnostics have been performed, the radio box is ungrayed. If theSubset by
series diagnosticsradio button is selected, only those models in the selection list that
fit the diagnostic criteria will be shown for selection. If you wish to choose models
that do not fit the diagnostic criteria, select theShow all models button.

Controls and Fields
Show all models

when selected, lists all available models, regardless of the setting of the series
diagnostics options.

Subset by series diagnostics
when selected, lists only the available models that are consistent with the series
diagnostics options.

OK
closes the Models to Fit window and fits the selected models.

Cancel
closes the window without fitting any models. Any selections you made are lost.
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Print Setup Window

Use the Print Setup window to select a print driver and options associated with it.
For most operating systems, host printing is used by default and is recommended.
This means that printing makes use of device drivers which you install through your
operating system, and works the same way as it does for other applications written for
this operating system. If your operating system does not support this, or you prefer to
use a particular SAS/GRAPH device driver, you can choose the SAS/GRAPH option.

This window comes up automatically the first time you print, if you have not already
specified the requested information. Once you have done so, your choices are saved
and the window does not come up again unless you choosePrint Setup from the
File pull-down menu.

Controls and Fields
Print Setup Options

lets you select host print drivers or SAS/GRAPH print drivers.

Color/Gray-scale/Monochrome radio box
specifies the SAS generic print driver to use in conjunction with a host print
driver. In most cases you can accept the default setting ofcolor .

Setup
brings up your operating system’s print setup window, if you are using
host drivers, or theGraphics Device Name window if you are using
SAS/GRAPH drivers. The Graphics Device Name window lets you specify a
device type (printer, plotter, camera, or export) and choose a device driver from
a device catalog.

OK
closes the Print Setup window and applies the specified options.

Cancel
closes the Print Setup window without making any changes.

Produce Forecasts Window

Use the Produce Forecasts window to produce forecasts for the series in the current
input data set for which you have fit forecasting models. Access it using thePro-
duce Forecasts button of the Time Series Forecasting window.
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Controls and Fields
Input Data Set

is the name of the current input data set. To specify the input data set, you can
type a one or two level SAS data set name in this field or select the Browse
button to the right of the field.

Input data setBrowse button
brings up the Data Set Selection window to enable you to select the input data
set.

Time ID
is the name of the time ID variable for the input data set. To specify this variable,
you can type the ID variable name in this field or use theSelect button.

Time ID Select button
brings up the Time ID Variable Specification window.

Create button
brings up a menu of choices of methods for creating a time ID variable for the
input data set. Use this feature if the input data set does not already contain a
valid time ID variable.

Interval
is the time interval between observations (data frequency) in the current input
data set. If the interval is not automatically filled in by the system, you can type
in an interval name here, or select one from the popup list.

Series
indicates the number and names of time series variables for which forecasts will
be produced.

SeriesSelect button
brings up theSeries to Process window to let you select the series for
which you want to produce forecasts.
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Forecast OutputData Set
is the name of the output data set that will contain the forecasts. Type the name
of the output data set in this field or click the Browse button.

Forecast OutputBrowse button
brings up a dialog to let you locate an existing data set to which to save the
forecasts.

Format
Lets you select one of three formats for the forecast data set:

Simple
specifies the simple format for the output data set. The data set contains the
time ID variable and the forecast variables and contains one observation
per time period. Observations for earlier time periods contain actual values
copied from the input data set; later observations contain the forecasts.

Interleaved
specifies the interleaved format for the output data set. The data set con-
tains the time ID variable, the variable TYPE, and the forecast variables.
There are several observations per time period, with the meaning of each
observation identified by the TYPE variable.

Concatenated
specifies the concatenated format for the output data set. The data set
contains the variable SERIES, the time ID variable, and the variables AC-
TUAL, PREDICT, ERROR, LOWER, and UPPER. There is one observa-
tion per time period per forecast series. The variable SERIES contains the
name of the forecast series, and the data set is sorted by SERIES and DATE.

Horizon
is the number of periods or years to forecast beyond the end of the input data
range. To specify the forecast horizon, you can type a value in this field or select
one from the popup list.

Horizon periods
selects the units to apply to the horizon. By default, the horizon value represents
number of periods. For example, if the interval is month, the horizon represents
the number of months to forecast. Depending on the interval, you can also select
weeks or years, so that the horizon is measured in those units.

Horizon date
is the ending date of the forecast horizon. You can type in a date using a form
recognized by a SAS date informat, or you can increment or decrement the date
shown using the left and right arrows. The outer arrows change the date by a
larger amount than the inner arrows. The date field and the horizon field reset
each other, so you can use either one to specify the forecasting horizon.

Run button
produces forecasts for the selected series and stores the forecasts in the specified
output SAS data set.

Output button
brings up a Viewtable window to display the output data set. This button be-
comes ungrayed once the forecasts have been written to the data set.
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Close button
closes the Produce Forecasts window and returns to the Time Series Forecasting
window.

Menu Bar
File

Import Data
is available if you license SAS/Access software. It brings up an Import
Wizard which you can use to import your data from an external spreadsheet
or data base to a SAS data set for use in the Time Series Forecasting System.

Export Data
is available if you license SAS/Access software. It brings up an Export
Wizard which you can use to export a SAS data set, such as a forecast
data set created with the Time Series Forecasting System, to an external
spreadsheet or data base.

Print Setup
brings up thePrint Setup window, which allows you to access your
operating system print setup or choose SAS/Graph print drivers.

Close
closes the Produce Forecasts window and returns to the Time Series Fore-
casting window.

View

Input Data Set
brings up a Viewtable window to browse the current input data set.

Output Data Set
brings up a Viewtable window to browse the output data set. This is the
same as theOutput button.

Tools

Produce Forecasts
produces forecasts for the selected series and stores the forecasts in the
specified output SAS data set. This is the same as theRun button.

Options

Default Time Ranges
brings up the Default Time Ranges window to enable you to control how
the system sets the time ranges when new series are selected.

Model Selection List
brings up the Model Selection List window. Use this to edit the set of
forecasting models considered by the automatic model selection process
and displayed by the Models to Fit window.
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Model Selection Criterion
brings up the Model Selection Criterion window, which presents a list of
goodness-of-fit statistics and enables you to select the fit statistic that is
displayed in the table and used by the automatic model selection process to
determine the best fitting model.

Statistics of Fit
brings up the Statistics of Fit Selection window, which presents a list of
statistics that the system can display. Use this action to customize the list
of statistics shown in the Statistics of Fit table and available for selection in
the Model Selection Criterion window.

Forecast Options
brings up the Forecast Options window, which enables you to control the
widths of forecast confidence limits and control the kind of predicted values
computed for models that include series transformations.

Forecast Data Set
lets you select one of three formats for the forecast data set. See the de-
scription underformat.

Alignment of Dates

Beginning
aligns dates that the system generates to identify forecast observations in
output data sets to the beginning of the time intervals.

Middle
aligns dates that the system generates to identify forecast observations in
output data sets to the midpoints of the time intervals.

End
aligns dates that the system generates to identify forecast observations in
output data sets to the end of the time intervals.

Automatic Fit
brings up the Automatic Model Selection Options window, which enables you to
control the number of models retained by the automatic model selection process
and whether the models considered for automatic selection are subset according
to the series diagnostics.

Set Toolbar Type

Image Only
displays the tool bar items as icons without text.

Label Only
displays the tool bar items as text without icon images.

Both
displays the tool bar items as both text and icon images.

Include Interventions
controls whether intervention effects defined for the current series are automat-
ically added as predictors to the models considered by the automatic selection
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process. A check mark or filled check box next to this item indicates that the
option is turned on.

Print Audit Trail
prints to the SAS log information about the models fit by the system. A check
mark or filled check box next to this item indicates that the audit option is turned
on.

Show Source Statements
controls whether SAS statements submitted by the forecasting system are printed
in the SAS log. When the Show Source Statements option is selected, the sys-
tem sets the SAS system option SOURCE before submitting SAS statements;
otherwise, the system uses the NOSOURCE option. Note that only some of the
functions performed by the forecasting system are accomplished by submitting
SAS statements. A check mark or filled check box next to this item indicates
that the option is turned on.

Regressors Selection Window

Use the Regressors Selection window to select one or more time series variables in the
input data set to include as regressors in the forecasting model to predict the depen-
dent series. Access it from the pop-up menu which appears when you select theAdd
button of the ARIMA Model Specification window or Custom Model Specification
window.

Controls and Fields
Dependent

is the name and variable label of the current series.

Regressors
is a table listing the names and labels of the variables in the input data set avail-
able for selection as regressors. The variables that you select are highlighted.
Selecting a highlighted row again deselects that variable.

OK
closes the Regressors Selection window and adds the selected variables as re-
gressors in the model.
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Cancel
closes the window without adding any regressors. Any selections you made are
lost.

Reset
resets all options to their initial values upon entry to the window.

Seasonal ARIMA Model Options Window

Use the Seasonal ARIMA Model Options window to specify the the autoregressive,
differencing, and moving average orders for the seasonal part of a model defined us-
ing theCustom Model Specification window. Access it by selectingSea-
sonal ARIMA... from theSeasonal Model combo box of that window.

Controls and Fields
ARIMA Options

Use these combo boxes to specify the orders of the ARIMA model. You can
either type in a value or click the combo box arrow to select from a popup
list.

Autoregressive
defines the order of the seasonal autoregressive part of the model.

Differencing
defines the order of seasonal differencing.

Moving Average
defines the order of the seasonal moving average term.

OK
closes the Seasonal ARIMA Model Options window and returns to theCustom
Model Specification window.

Cancel
closes the Seasonal ARIMA Model Options window and returns to theCustom
Model Specification window, discarding any changes made.

Reset
resets all options to their initial values upon entry to the window.
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Series Diagnostics Window

Use the Series Diagnostics window to set options to limit the kinds of forecasting
models considered for the series according to series characteristics. Access it by se-
lectingDiagnose Series from the Tools pull-down menu in the Develop Mod-
els, Manage Project, and Time Series Viewer window menu bars. You can let the
system diagnose the series’ characteristics automatically or you can specify series
characteristics according to your judgment using the radio buttons.

For each of the options Log Transform, Trend, and Seasonality, the valueYesmeans
that only models appropriate for series with that characteristic should be considered.
The valueNomeans that only models appropriate for series without that characteristic
should be considered. The valueMaybemeans that models should be considered
without regard for that characteristic.

Controls and Fields
Series

is the name and variable label of the current series.

Series Characteristics

Log Transform
specifies whether forecasting models with or without a logarithmic series
transformation are appropriate for the series.

Trend
specifies whether forecasting models with or without a trend component
are appropriate for the series.

Seasonality
specifies whether forecasting models with or without a seasonal component
are appropriate for the series.

Automatic Series Diagnostics
performs the automatic series diagnostic process. The options Log Transform,
Trend, and Seasonality are set according to the results of statistical tests.
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OK
closes the Series Diagnostics window.

Cancel
closes the Series Diagnostics window without changing the series diagnostics
options. Any options you specified are lost.

Reset
resets all options to their initial values upon entry to the Series Diagnostics win-
dow.

Clear
resets all options to their default values.

Series Selection Window

Use this resizable window to select a time series variable by specifying a library, a
SAS data set or view, and a variable. These selections can be made by typing, by
selecting from lists, or by a combination of the two. In addition, you can control the
time ID variable and time interval, and you can browse the data set or view plots of
the series from this window.

This window appears automatically when you select theView Series Graph-
ically or Develop Models buttons in the Time Series Forecasting window and
no series has been selected, and when you bring up the Time Series Viewer as a
standalone tool. It is also invoked using the Browse button in the Develop Models
window.

The system requires that series names be unique for each frequency (interval) within
the forecasting project. If you select a series from the current input data set that
already exists in the project with the same interval but a different input data set name,
the system warns you and gives you the option to cancel the selection, to refit all
models associated with the series using the data from the current input data set, to
delete the models for the series, or to inherit the existing models.
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Controls and Fields
Library

is a SAS libname assigned within the current SAS session. If you know the
libname associated with the data set of interest, you can type it in this field and
press Return. If it is a valid choice, it will appear in the libraries list and will be
highlighted. The SAS Data Sets list will be populated with data sets associated
with that libname.

Data Set
is the name of a SAS data set (data file or data view) that resides under the
selected libname. If you know the name, you can type it in and press Return. If it
is a valid choice, it will appear in the SAS Data Sets list and will be highlighted,
and the Time Series Variables list will be populated with the numeric variables
in the data set.

Variable
is the name of a numeric variable contained in the selected data set. You can
type the variable name in this field or you can select the variable with the mouse
from the Time Series Variables list.

Time ID
is the name of the ID variable for the input data set. To specify the ID variable,
you can type the ID variable name in this field or click theSelect button.

Select button
brings up the Time ID Variable Specification window to let you select an existing
variable in the data set as the Time ID.

Create button
brings up a menu of methods for creating a time ID variable for the input data
set. Use this feature if the data set does not already contain a valid time ID
variable.

Interval
is the time interval between observations (data frequency) in the selected data
set. If the interval is not automatically filled in by the system, you can type in
an interval name or select one from the popup list. For more information on
intervals, see Chapter 3, “Date Intervals, Formats, and Functions,” in this book.

OK
This button is present when you have selectedDevelop Models from the
Time Series Forecasting Window. It closes the Series Selection window and
makes the selected series the current series.

Close
If you have selected theView Series Graphically icon from the Time
Series Forecasting window, this button returns you to that window. If you have
selected a series, it remains selected as the current series.

If you are using theTime Series Viewer as a standalone application, this
button closes the application.
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Cancel
This button is present when you have selectedDevelop Models from the
Time Series Forecasting Window. It closes the Series Selection window without
applying any selections made.

Reset
resets the fields to their initial values at entry to the window.

Table
brings up a Viewtable window for browsing the selected data set. This can assist
you in locating the variable containing data you are looking for.

Graph
brings up the Time Series Viewer window to display the selected time series
variable. You can switch to a different series in the Series Selection window
without closing the Time Series Viewer window. Position the windows so they
are both visible, or use theNext Viewer tool bar icon or F12 function key to
switch between windows.

Refresh
updates all fields and lists on the window. If you assign a new libname with-
out exiting the Series Selection window, use the refresh action to update the
Libraries list so that it will include the newly assigned libname. Also use the
Refresh action to update the variables list if the input data set is changed.

Selection Lists
Libraries

displays a list of currently assigned libnames. You can select a libname by click-
ing it with the left mouse button, which is equivalent to typing its name in the
Library field. If you cannot locate the library or directory you are interested
in, go to the SASExplorer window, selectNew from theFile pull-down
menu, then selectLibrary andOK. This brings up theNew Library dialog
window. You also assign a libname by submitting alibname statement from
the Program window. Select theRefresh button to make the new libname
available in the libraries list.

SAS Data Sets
displays a list of the SAS data sets (data files or data views) located under the
selected libname. You can select one of these by clicking with the left mouse
button, which is equivalent to typing its name in the Data Set field.

Time Series Variables
displays a list of numeric variables contained within the selected data set. You
can select one of these by clicking with the left mouse button, which is equiva-
lent to typing its name in the Variable field. You can double-click on a series to
select it and exit the window.

Series to Process Window

Use the Series to Process window to select series for model fitting or forecasting.
Access it using theSelect button in the Automatic Model Fitting and Produce
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Forecasts windows. Hold down the shift key or drag with the left mouse button for
multiple selections. Use the control key for noncontiguous multiple selections. Once
you make selections and select OK, the number of selected series and their names are
listed in the Series to Process field of the calling window (with ellipses if not all the
names will fit).

When invoked from Automatic Model Fitting, the Series to Process window shows
all the numeric variables in the input data set except the time id variable. These are
the series which are currently available for model fitting.

When invoked from Produce Forecasts, the Series to Process window shows all the
series in the input data set for which models have been fit. These are the series which
are currently available for forecasting.

Controls and Fields
OK

closes the window and applies the series selection(s) which have been made. At
least one series must be selected to close the window.

Cancel
closes the window, ignoring series selections which have been made, if any.

Clear
deselects all series in the selection list.

All
selects all series in the selection list.

Series Viewer Transformations Window

Use the Series Viewer Transformations window to view plots of transformations of
the current series in the Time Series Viewer window. It provides a larger set of trans-
formations than those available from the viewer window’s tool bar. It is invoked using
Other Transformations under the Tools pull-down menu of the Time Series
Viewer window. The options that you specify in this window are applied to the series
displayed in the Time Series Viewer window when you selectOKor Apply .
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Use the Apply button if you want to make repeated transformations to a series without
having to close and reopen the Series Viewer Transformations window each time.

Controls and Fields
Series

is the variable name for the current time series.

Transformation
is the transformation applied to the time series displayed in the Time Series
Viewer window. Select Log, Logistic, Square Root, Box-Cox, or none from the
popup list.

Simple Differencing
is the order of differencing applied to the time series displayed in the Time Series
Viewer window. Select a number from 0 to 5 from the popup list.

Seasonal Differencing
is the order of seasonal differencing applied to the time series displayed in the
Time Series Viewer window. Select a number from 0 to 3 from the popup list.

Percent Change
is a check box that if selected displays the series in terms of percent change from
the previous period.

Additive Decomposition
is a check box which produces a display of a selected series component derived
using additive decomposition.

Multiplicative Decomposition
is a check box which produces a display of a selected series component derived
using multiplicative decomposition.

Component
selects a series component to display when either additive or multiplicative de-
composition is turned on. You can display the seasonally adjusted component,
the trend-cycle component, the seasonal component, or the irregular component,
that is, the residual which remains after removal of the other components. The
heading in the viewer window shows which component is currently displayed.
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OK
applies the transformation options you selected to the series displayed in the
Time Series Viewer window and closes the Series Viewer Transformations win-
dow.

Cancel
closes the Series Viewer Transformations window without changing the series
displayed by the Time Series Viewer window.

Apply
applies the transformation options you selected to the series displayed in the
Time Series Viewer window without closing the Series Viewer Transformations
window.

Reset
resets the transformation options to their initial values upon entry to the Series
Viewer Transformations window.

Clear
resets the transformation options to their default values (no transformations).

Smoothing Model Specification Window

Use the Smoothing Model Specification window to specify and fit exponential
smoothing and Winters method models. Access it from the Develop Models win-
dow using the Fit Model submenu of the Edit pull-down or from the pop-up menu
when you click an empty area of the model table.

Controls and Fields
Series

is the name and variable label of the current series.

Model
is a descriptive label for the model that you specify. You can type a label in this
field or allow the system to provide a label. If you leave the label blank, a label
is generated automatically based on the options you specify.
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Smoothing Methods

Simple Smoothing
specifies simple (single) exponential smoothing.

Double (Brown) Smoothing
specifies double exponential smoothing using Brown’s one parameter
model (single exponential smoothing applied twice).

Seasonal Smoothing
specifies seasonal exponential smoothing. (This is like Winters method
with the trend term omitted.)

Linear (Holt) Smoothing
specifies exponential smoothing of both the series level and trend (Holt’s
two parameter model).

Damped-Trend Smoothing
specifies exponential smoothing of both the series level and trend with a
trend damping weight.

Winters Method - Additive
specifies Winters method with additive seasonal factors.

Winters Method - Multiplicative
specifies Winters method with multiplicative seasonal factors.

Smoothing Weights
displays the values used for the smoothing weights. By default, the Smoothing
Weights fields are set tooptimize , which means that the system will compute
the weight values that best fit the data. You can also type smoothing weight
values in these fields.

Level
is the smoothing weight used for the level of the series.

Trend
is the smoothing weight used for the trend of the series.

Damping
is the smoothing weight used by the damped-trend method to damp the
forecasted trend towards zero as the forecast horizon increases.

Season
is the smoothing weight used for the seasonal factors in Winters method
and seasonal exponential smoothing.

Transformation
displays the series transformation specified for the model. When a transforma-
tion is specified, the model is fit to the transformed series, and forecasts are pro-
duced by applying the inverse transformation to the model predictions. Select
Log, Logistic, Square Root, Box-Cox, or None from the popup
list.
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Bounds
displays the constraints imposed on the fitted smoothing weights. Select one of
the following from the popup list:

Zero-One/Additive
sets the smoothing weight optimization region to the the intersection of the
region bounded by the intervals from zero (0.001) to one (0.999) and the
additive invertible region. This is the default.

Zero-One Boundaries
sets the smoothing weight optimization region to the region bounded by the
intervals from zero (0.001) to one (0.999).

Additive Invertible
sets the smoothing weight optimization region to the additive invertible re-
gion.

Unrestricted
sets the smoothing weight optimization region to be unbounded.

Custom
brings up theSmoothing Weights window to enable you to customize
the constraints for smoothing weights optimization.

OK
closes the Smoothing Model Specification window and fits the model you spec-
ified.

Cancel
closes the Smoothing Model Specification window without fitting the model.
Any options you specified are lost.

Reset
resets all options to their initial values upon entry to the window. This may be
useful when editing an existing model specification; otherwise, Reset has the
same function as Clear.

Clear
resets all options to their default values.

Smoothing Weight Optimization Window

Use the Smoothing Weight Optimization window to specify constraints for the au-
tomatic fitting of smoothing weights for exponential smoothing and Winters method
models. Access it from the Smoothing Models Specification window when you select
Custom in theBounds combo box.
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Controls and Fields
No restrictions

when selected, specifies unrestricted smoothing weights.

Bounded region
when selected, restricts the fitted smoothing weights to be within the bounds that
you specify with theSmoothing Weight Bounded Region options.

Additive invertible region
when selected, restricts the fitted smoothing weights to be within the additive
invertible region of the parameter space of the ARIMA model equivalent to the
smoothing model. (See the section "Smoothing Models" in Chapter 30, “Fore-
casting Process Details,” for details.)

Additive invertible and bounded region
when selected, restricts the fitted smoothing weights to be both within the addi-
tive invertible region and within bounds that you specify.

Smoothing Weight Bounded Region
is a group of numeric entry fields that enable you to specify lower and upper
limits on the fitted value of each smoothing weight. The fields that appear in this
part of the window depend on the kind of smoothing model that you specified.

OK
closes the window and sets the Bounds options that you specified.

Cancel
closes the window without changing the Bounds option. Any values you speci-
fied are lost.

Reset
resets all options to their initial values upon entry to the window.

Clear
resets all options to their default values.

Statistics of Fit Selection Window

Use the Statistics of Fit Selection window to specify which of the available goodness-
of-fit statistic are reported for models you fit and are available for selection as the
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model selection criterion used by the automatic selection process. This window
is available under the Options pull-down menu in the Develop Models, Automatic
Model Fitting, Produce Forecasts, and Model List windows, and from the Statistics
button of the Model Fit Comparison window and Automatic Model Fitting results
windows.

Controls and Fields
Available Statistics Table

list the available statistics. Select a row of the table to select or deselect the
statistic shown in that row.

OK
closes the window and applies the selections made.

Cancel
closes the window without applying any selections.

Clear
deselects all statistics.

All
selects all statistics.

Time ID Creation – 1,2,3 Window

Use theTime ID Creation - 1,2,3 window to add a time ID variable to an
input data set with observation numbers as the ID values. The interval for the series
will be 1. Use this approach if the data frequency does not match any of the system’s
date or date-time intervals, or if other methods of assigning a time ID do not work.
To access this window, selectCreate from observation numbers from the
theCreate popup list in any window where you can select a Time ID variable. For
more information, see Chapter 3, “Date Intervals, Formats, and Functions,” in this
book.
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Controls and Fields
Data set name

is the name of the input data set.

New ID variable name
is the name of the time ID variable to be created. You can type any valid SAS
variable name in this field.

OK
closes the window and proceeds to the next step in the time ID creation process.

Cancel
closes the window without creating a Time ID variable Any options you speci-
fied are lost.

Time ID Creation from Several Variables Window

Use the Time ID Creation from Several Variables window to add a SAS date valued
time ID variable to an input data set when the input data set already contains several
dating variables, such as day, month, and year. To access this window, selectCreate
from existing varibles from theCreate popup list in any window where
you can select a Time ID variable. For more information, seeCreating Time ID
Variablesin this book.
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Controls and Fields
Variables

is a list of variables in the input data set. Select existing ID variables from this
list.

Date Part
is a list of date parts that you can specify for the selected ID variable. For each
ID variable that you select from the Variables list, select the Date Part value that
describes what the values of the ID variable represent.

arrow button
Use this button to move the selected existing ID variable and date part specifi-
cation to theExisting Time IDs list. Once you have done this, you can
select another ID variable from the Variables list.

New variable
is the name of the time ID variable to be created. You can type any valid SAS
variable name in this field.

New interval
is the time interval between observations in the input data set implied by the date
part ID variables you have selected.

OK
closes the window and proceeds to the next step in the time ID creation process.

Cancel
closes the window without creating a time ID. Any options you specified are
lost.

Reset
resets the options to their initial values upon entry to the window.

Time ID Creation from Starting Date Window

Use the Time ID Creation from Starting Date window to add a SAS date valued
time ID variable to an input data set. This is a convenient way to add a time ID
of any interval as long as you know the starting date of the series. To access this
window, selectCreate from starting date and frequency from the
Create popup list in any window where you can select a Time ID variable. For
more information, seeCreating Time ID Variablesin this book.
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Controls and Fields
Data set name

is the name of the input data set.

Starting Date
is the starting date for the time series in the data set. Enter a date value in this
field, using a form recognizable by a SAS date informat, for example, 1998:1,
feb1997, or 03mar1998.

Interval
is the time interval between observations in the data set. Select an interval from
the popup list.

New ID variable name
is the name of the time ID variable to be created. You can type any valid SAS
variable name in this field.

OK
closes the window and proceeds to the next step in the time ID creation process.

Cancel
closes the window without changing the input data set. Any options you speci-
fied are lost.

Time ID Creation using Informat Window

Use the Time ID Creation using Informat window to add a SAS date valued time
ID variable to an input data set. Use this window if your data set contains a date
variable which is stored as a character string. Using the appropriate SAS date in-
format, the date string is read in and used to create a date or date-time variable. To
access this window, selectCreate from existing variable/informat
from theCreate popup list in any window where you can select a Time ID variable.

Controls and Fields
Variable Name

is the name of an existing ID variable in the input data set. Click theSelect
button to select a variable.

1439
SAS OnlineDoc: Version 8



Part 3. General Information

Select button
brings up a list of variables in the input data set for you to select from.

Informat
is a SAS date or datetime informat for reading date or datetime value from the
values of the specified existing ID variable. You can type in an informat or select
one from the popup list.

First Obs
is the value of the variable you selected from the first observation in the data set,
displayed here for convenience.

Date Value
is the SAS date or datetime value read from the first observation value using the
informat that you specified.

New ID variable name
is the name of the time ID variable to be created. You can type any valid SAS
variable name in this field.

OK
closes the window and proceeds to the next step in the time ID creation process.

Cancel
closes the window without changing the input data set. Any options you speci-
fied are lost.

Reset
resets the options to their initial values upon entry to the window.

Time ID Variable Specification Window

Use the Time ID Variable Specification window to specify a variable in the input data
set which contains the SAS date or datetime value of each observation. You do not
need to use this window if your time ID variable is nameddate , time , or date-
time , since these are picked up automatically. Invoke the window from theSelect
button to the right of the Time ID field in the Data Set Selection, Automatic Model
Fitting, Produce Forecasts, Series Selection, and Time Series Forecasting windows.
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Controls and Fields
Data Set

is the name of the current input data set.

Time ID
is the name of the currently selected Time ID variable, if any.

Interval
is the time interval between observations (data frequency) in the input data set.

Select a Time ID Variable
is a selection list of variables in the input set. Select one variable to assign it as
the Time ID variable.

OK
closes the window and retains the selection made, if it is a valid time ID.

Cancel
closes the window and ignores any selection made.

Reset
restores the time ID variable to the one assigned when the window was initially
opened, if any.

Time Ranges Specification Window

Use the Time Ranges Specification window to control the period of fit and evaluation
and the forecasting horizon. Invoke this window from the Options menu in the De-
velop Models, Manage Forecasting Project, and Model Viewer windows or theSet
Ranges button in the Develop Models window.

Controls and Fields
Data Set

is the name of the current input data set.

Interval
is the time interval (data frequency) for the input data set.

Series
is the variable name and label of the current time series.
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Data Range
gives the date of the first and last nonmissing data values available for the current
series in the input data set.

Period of Fit
gives the starting and ending dates of the period of fit. This is the time range
used for estimating model parameters. By default, it is the same as the data
range. You can type dates in these fields, or you can use the arrow buttons to the
left and right of the date fields to decrement or increment the date values shown.
Date values must be entered in a form recognized by a SAS date informat. (Refer
to SAS Language Referencefor information on SAS date informats.) The inner
arrows increment by periods, the outer arrows increment by larger amounts,
depending on the data interval.

Period of Evaluation
gives the starting and ending dates of the period of evaluation. This is the time
range used for evaluating models in terms of statistics of fit. By default, it is the
same as the data range. You can type dates in these fields, or you can use the
control arrows to the left and right of the date fields to decrement or increment
the date values shown. Date values must be entered in a form recognized by
a SAS date informat. (Refer toSAS Language Referencefor information on
SAS date informats.) The inner arrows increment by periods, the outer arrows
increment by larger amounts, depending on the data interval.

Forecast Horizon
is the forecasting horizon expressed as a number of forecast periods or number
of years (or number of weeks for daily data). You can type a number or select
one from the popup list. The ending date for the forecast period is automatically
updated when you change the number of forecasts periods.

Forecast Horizon - Units
indicates whether the Forecast Horizon value represents periods or years (or
weeks for daily data).

Forecast Horizon Date Value
is the date of the last forecast observation. You can type a date in this field, or
you can use the arrow buttons to the left and right of the date field to decre-
ment or increment the date values shown. Date values must be entered in a form
recognized by a SAS date informat. (Refer toSAS Language Referencefor infor-
mation on SAS date informats.) The Forecast Horizon is automatically updated
when you change the ending date for the forecast period.

Hold-out Sample
specifies that a number of observations or years (or weeks) of data at the end
of the data range are used for the period of evaluation with the remainder of
data used as the period of fit. You can type a number in this field or select one
from the popup list. When the hold-out sample value is changed, the Period of
Fit and Period of Evaluation ranges are changed to reflect the hold-out sample
specification.

Hold-out Sample - Units
indicates whether the hold-out sample field represents periods or years (or weeks
for daily data).
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OK
closes the window and stores the specified changes.

Cancel
closes the window without saving changes. Any options you specified are lost.

Reset
resets the options to their initial values upon entry to the window.

Clear
resets all options to their default values.

Time Series Forecasting Window

The Time Series Forecasting window is the main application window which appears
when you invoke the Time Series Forecasting System. It allows you to specify a
project file and an input data set and provides access to the other windows described
in this chapter.

Controls and Fields
Project

is the name of the SAS catalog entry in which forecasting models and other
results will be stored and from which previously stored results are loaded into the
forecasting system. You can specify the project by typing a SAS catalog entry
name in this field or by selecting theBrowse button to right of this field. If you
specify the name of an existing catalog entry, the information in the project file
is loaded. If you specify a one level name, the catalog name is assumed to be
fmsproj and the library is assumed to besasuser . For example,samprojis
equivalent tosasuser.fmsproj.samproj.

ProjectBrowse button
brings up the Forecasting Project File Selection window to enable you to select
and load the project from a list of previously stored projects.

Description
is a descriptive label for the forecasting project. The description you type in this
field will be stored with the catalog entry shown in the Project field.
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Data Set
is the name of the current input data set. To specify the input data set, you can
type the data set name in this field or use theBrowse button to the right of the
field.

Data setBrowse button
brings up the Data Set Selection window to enable you to select the input data
set.

Time ID
is the name of the ID variable for the input data set. To specify the ID variable,
you can type the ID variable name in this field or use theSelect button. If
the time ID variable is nameddate , time , or datetime , it is automatically
picked up by the system.

Select button
brings up the Time ID Variable Specification window.

Create button
brings up a menu of choices of methods for creating a time ID variable for the
input data set. Use this feature if the input data set does not already contain a
valid time ID variable.

Interval
is the time interval between observations (data frequency) in the current input
data set. If the interval is not automatically filled in, you can type an interval
name or select one from the popup list. For more information on intervals, see
Time Series Data Sets, ID variables, and Time Intervalsin this book.

View Series Graphically icon
brings up the Time Series Viewer window to display plots of series in the current
input data set.

View Data as a Table
brings up a Viewtable window for browsing the selected input data set.

Develop Models
brings up the Develop Models window to enable you to fit forecasting models
to individual time series and choose the best models to use to produce the final
forecasts of each series.

Fit Models Automatically
brings up the Automatic Model Fitting window for applying the automatic model
selection process to all series or to selected series in an input data set.

Produce Forecast
brings up the Produce Forecasts window for producing forecasts for the series
in the current input data set for which you have fit forecasting models.

Manage Projects
brings up the Manage Forecasting Project window for viewing or editing infor-
mation stored in projects.

Exit
closes the Time Series Forecasting system.
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Help
accesses the help system.

Time Series Simulation Window

Use the Time Series Simulation window to create a data set of simulated series gen-
erated by ARIMA processes. Access this window from the Tools pull-down menu in
the Develop Models and Manage Forecasting Project windows.

Controls and Fields
Output Data Set

is the name of the data set to be created. Type in a one or two level SAS data set
name.

Interval
is the time interval between observations (data frequency) in the simulated data
set. Type in an interval name or select one from the popup list.

Seed
is the seed for the random number generator used to produce the simulated time
series.

N Observations
is the number of time periods to simulate.

Starting Date
is the starting date for the simulated observations. Type in a date in a form rec-
ognizable by a SAS data informat, for example, 1998:1, feb1997, or 03mar1998.

Ending Date
is the ending date for the simulated observations. Type in a date in a form rec-
ognizable by a SAS data informat.

Series to Generate
is the list of variable names and ARIMA processes to simulate.

Add Series
brings up the ARIMA Process Specification window to enable you to add entries
to the Series to Generate list.
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Delete Series
deletes selected (highlighted) entries from the Series to Generate list.

OK
closes the Time Series Simulation window and performs the specified simula-
tions and creates the specified data set.

Cancel
closes the window without creating a simulated data set. Any options you spec-
ified are lost.

Time Series Viewer Window

Use the Time Series Viewer window to explore time series data using plots, tranfor-
mations, statistical tests, and tables. It is available as a standalone application and as
part of the Time Series Forecasting System. To use it as a standalone application, se-
lect it from theAnalysis submenu of theSolutions pull-down menu, or use the
tsview command (see Chapter 28, “Command Reference,” in this book). To use
it within the Time Series Forecasting System, select theView Series Graphi-
cally icon in the Time Series Forecasting, Develop Models, or Model List window,
or selectSeries from theView pull-down menu of the Develop Models, Manage
Project, or Model List window.

The various plots and tables available are referred to asviews. The followingView
Selection Iconssection explains how to change the view.

The state of the Time Series Viewer window is controlled by the current series, the
current series transformation specification, and the currently selected view. You can
resize this window, and you can use other windows without closing the Time Series
Viewer window. You can explore a number of series conveniently by keeping the
Series Selection window open. Each time you make a selection, the viewer window
is updated to show the selected series. Keep both windows visible, or switch between
them using theNext Viewer tool bar icon or the F12 function key.
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You can bring up multiple Time Series Viewer windows. This enables you to "freeze"
a plot so you can come back to it later, or compare two plots side by side on your
screen. To do this, unlink the viewer using theLink/Unlink icon on the window’s
tool bar or the corresponding item in theTools pull-down menu. While the viewer
window remains unlinked, it is not updated when other selections are made in the
Series Selection window. Instead, when you select a series and click thegraph
button, a new Time Series Viewer window is invoked. You can continue this process
to bring up as many viewer windows as you want. TheNext Viewer icon and
corresponding F12 function key are useful for navigating between windows when
they are not simulataneously visible on your screen.

A wide range of series transformations is available. Basic transformations are avail-
able from the window’s horizontal tool bar, and others are available by selecting
Other Transformations from theTools pull-down menu.

Horizontal Tool Bar
The Time Series Viewer window contains a horizontal tool bar with the following
icons:

Zoom in
changes the mouse cursor into cross hairs that you can use with the left mouse
button to drag out a region of the time series plot to zoom in on. In the Au-
tocorrelations view and the White Noise and Stationarity Tests view, Zoom In
reduces the number of lags displayed.

Zoom out
reverses the previous Zoom In action and expands the time range of the plot to
show more of the series. In the Autocorrelations view and the White Noise and
Stationarity Tests view, Zoom Out increases the number of lags displayed.

Link/Unlink viewer
disconnects or connects the Time Series Viewer window to the window in which
the series was selected. When the Viewer is linked, it always shows the current
series. If you select another series, linked Viewers are updated. Unlinking a
Viewer freezes its current state, and changing the current series has no effect on
the Viewer’s display. TheView Series action creates a new Series Viewer
window if there is no linked Viewer. By using the unlink feature, you can bring
up several Time Series Viewer windows and display several different series si-
multaneously.

Log Transform
applies a log transform to the current view. This can be combined with other
transformations: The current transformations are shown in the title.

Difference
applies a simple difference to the current view. This can be combined with other
transformations: The current transformations are shown in the title.

Seasonal Difference
applies a seasonal difference to the current view. For example, if the data are
monthly, the seasonal cycle is one year. Each value has subtracted from it the
value from one year previous. This can be combined with other transformations:
The current transformations are shown in the title.
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Close
closes the Time Series Viewer window and returns to the window from which it
was invoked.

Vertical Toolbar View Selection Icons
At the right-hand side of the Time Series Viewer window is a vertical tool bar used
to select the kind of plot or table that the Viewer displays.

Series
displays a plot of series values over time.

Autocorrelations
displays plots of the sample autocorrelations, partial autocorrelation, and inverse
autocorrelation functions for the series, with lines overlaid at plus and minus two
standard errors.

White Noise and Stationarity Tests
displays horizontal bar charts representing results of white noise and stationarity
tests. The first bar chart shows the significance probability of the Ljung-Box chi-
square statistic computed on autocorrelations up to the given lag. Longer bars
favor rejection of the null hypothesis that the series is white noise. Click on any
of the bars to display an interpretation.

The second bar chart shows tests of stationarity, where longer bars favor the
conclusion that the series is stationary. Each bar displays the significance prob-
ability of the augmented Dickey-Fuller unit root test to the given autoregressive
lag. Long bars represent higher levels of significance against the null hypothesis
that the series contains a unit root. For seasonal data, a third bar chart appears
for seasonal root tests. Click on any of the bars to display an interpretation.

Data Table
displays a data table containing the values in the input data set.

Menu Bar
File

Save Graph
saves the current plot as a SAS/GRAPHgrseg catalog entry in a default
or most recently specified catalog. This item is grayed out in theData Table
view.

Save Graph as
saves the current plot as a SAS/GRAPHgrseg catalog entry in a SAS
catalog that you specify. This item is grayed out in theData Tableview.

Save Data
saves the data displayed in the viewer window to an output SAS data set.
This item is grayed out in theSeriesview.

Save Data as
brings up the Output Data Set window, then saves the data displayed in the
viewer window to the specified SAS data set. This item is grayed out in the
Seriesview.
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Import Data
is available if you license SAS/Access software. It brings up an Import
Wizard which you can use to import your data from an external spreadsheet
or data base to a SAS data set for use in the Time Series Forecasting System.

Export Data
is available if you license SAS/Access software. It brings up an Export
Wizard which you can use to export a SAS data set, such as a forecast
data set created with the Time Series Forecasting System, to an external
spreadsheet or data base.

Print Graph
prints the plot displyed in the viewer window. This item is grayed out in
theData Tableview.

Print Data
prints the data displayed in the viewer window. This item is grayed out in
theSeriesview.

Print Setup
brings up thePrint Setup window, which allows you to access your
operating system print setup or choose SAS/Graph print drivers.

Print Preview
brings up a preview window to show how your plots will look when printed.
This item is grayed out ifUse host driversis not selected in thePrint Setup
window.

Close
closes the Time Series Viewer window and returns to the window from
which it was invoked.

View

Series
displays a plot of series values over time. This is the same as theSeries
icon in the vertical tool bar.

Autocorrelations
displays plots of the sample autocorrelation, partial autocorrelation, and
inverse autocorrelation functions for the series. This is the same as the
Autocorrelations icon in the vertical tool bar.

White Noise and Stationarity Tests
displays horizontal bar charts representing results of white noise and sta-
tionarity tests. This is the same as theWhite Noise and Station-
arity Tests icon in the vertical tool bar.

Data Table
displays a data table containing the values in the input data set. This is the
same as the Data Table icon in the vertical tool bar.

Zoom In
zooms the display. This is the same as the Zoom In icon in the window’s
horizontal tool bar.
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Zoom Out
undoes the last zoom in action. This is the same as the Zoom Out icon in
the window’s horizontal tool bar.

Zoom Way Out
reverses all previous Zoom In actions and expands the time range of the
plot to show all of the series, or shows the maximum number of lags in the
Autocorrelations View or the White Noise and Stationarity Tests view.

Tools

Log Transform
applies a log transformation. This is the same as theLog Transform
icon in the window’s horizontal tool bar.

Difference
applies simple differencing. This is the same as theDifference icon in
the window’s horizontal tool bar.

Seasonal Difference
applies seasonal differencing. This is the same as theSeasonal Dif-
ference icon in the window’s horizontal tool bar.

Other Transformations
brings up theSeries Viewer Transformations window to enable
you to apply a wide range of transformations.

Diagnose Series
brings up theSeries Diagnostics window to determine the kinds
of forecasting models appropriate for the current series.

Define Interventions
brings up theInterventions for Series window to enable you to
edit or add intervention effects for use in modeling the current series.

Link Viewer
connects or disconnects the Time Series Viewer window to the window
from which series are selected. This is the same as the Link item in the
window’s horizontal tool bar.

Options

Number of Lags
brings up a window to let you specify the number of lags shown in the
Autocorrelations view and theWhite Noise and Station-
arity Tests view. You can also use the Zoom In and Zoom Out actions
to control the number of lags displayed.

Correlation Probabilities
controls whether the bar charts in the Autocorrelations view represent sig-
nificance probabilities or values of the correlation coefficient. A check
mark or filled check box next to this item indicates that significance prob-
abilities are displayed. In each case the bar graph horizonal axis label
changes accordingly.
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Mouse Button Actions
You can examine the data value and date of individual points in the Series view by
positioning the mouse cursor over the point and clicking the left mouse button. The
date and value are displayed in a box that appears in the upper right corner of the
Viewer window. Click the mouse elsewhere or select any action to dismiss the data
box.

You can examine the values of the bars and confidence limits at different lags in the
Autocorrelations view by clicking on individual bars in the vertical bar charts.

You can display an interpretation of the tests in the White Noise and Stationarity Tests
view by clicking on the bars.

When you select the Zoom In action, you can use the mouse to define a region of the
graph to take a closer look at. Position the mouse cursor at one corner of the region,
press the left mouse button, and move the mouse cursor to the opposite corner of
the region while holding the left mouse button down. When you release the mouse
button, the plot is redrawn to show an expanded view of the data within the region
you selected.
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